
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
  

www.amershambiosciences.com 
 



 
 

 

 



Waste Electrical and Electronic Equipment (WEEE) 
 
ENG 
 

 

This symbol indicates that the waste of electrical and electronic equipment 
must not be disposed as unsorted municipal waste and must be collected 
separately. Please contact an authorized representative of the manufacturer 
for information concerning the decommissioning of your equipment . 

 
FRA 
 

 

Ce symbole indique que les déchets relatifs à l'équipement électrique et 
électronique ne doivent pas être jetés comme les ordures ménagères non-
triées et doivent être collectés séparément . Contactez un représentant agréé 
du fabricant pour obtenir des informations sur la mise au rebut de votre 
équipement . 

 
GER 
 

 

Dieses Symbol kennzeichnet elektrische und elektronische Geräte, die nicht mit 
dem gewöhnlichen, unsortierten Hausmüll entsorgt werden dürfen, sondern 
separat behandelt werden müssen. Bitte nehmen Sie Kontakt mit einem 
autorisierten Beauftragten des Herstellers auf, um Informationen hinsichtlich 
der Entsorgung Ihres Gerätes zu erhalten. 

 
ITA 
 

 

Questo simbolo indica che i rifiuti derivanti da apparecchiature elettriche ed 
elettroniche non devono essere smaltiti come rifiuti municipali indifferenziati e 
devono invece essere raccolti separatamente. Per informazioni relative alle 
modalità di smantellamento delle apparecchiature fuori uso, contattare un 
rappresentante autorizzato del fabbricante. 

 
SPA 
 

 

Este símbolo indica que el equipo eléctrico y electrónico no debe tirarse con los 
desechos domésticos y debe tratarse por separado. Contacte con el 
representante local del fabricante para obtener más información sobre la forma 
de desechar el equipo. 

 
SWE 
 

 

Denna symbol anger att elektriska och elektroniska utrustningar inte får 
avyttras som osorterat hushållsavfall och måste samlas in separat . Var god 
kontakta en auktoriserad tillverkarrepresentant för information angående 
avyttring av utrustningen. 
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CE Conformity 
 
The following Gel Imaging Digital Systems, 
 
Models: ImageQuant-100, ImageQuant-300, ImageQuant-400, ImageQuant-ECL  
 
Are in conformity with the provisions of the following EC Directives, including all amendments, 
and national legislation implementing these directives: 
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Chapter 1: Introduction and Setup 
1.1 ImageQuant Capture Imaging System 
The ImageQuant Imaging System is a powerful digital imaging system, ideal for instant 
photography of a wide variety of samples.  The CCD camera allows imaging of low-light 
samples in UV-illuminated, and fluorescent applications. 
 
The instrument is controlled by ImageQuant™ Capture software, which is designed with 
ease-of-use in mind. ImageQuant Capture handles image acquisition and archiving, and 
can be used to prepare images for desktop publishing. 
 
ImageQuant Capture includes tools to optimize the image display by adjusting contrast 
automatically or manually.  Hard-to-see portions of the image can be clarified by 
converting the image from positive to negative, using digital filters, or applying a false 
color map.  Notes, labels, arrows, lines and other drawing tools can be recorded directly 
on the image using the annotation functions available in ImageQuant Capture. 
Annotations are superimposed on the image when a hard copy is printed and can either be 
saved as a template file or as part of the image.  All of these features are accessible via 
convenient on-screen buttons and menus controlled by the mouse. 
 
ImageQuant Capture can also be used to transfer an acquired image to one of the 
ImageQuant TL modules for detailed analysis.  
 
The ImageQuant System is a complete package, including all the hardware and software 
needed for image capture, enhancement and analysis.  The system's computer need not be 
solely dedicated to ImageQuant Capture and can also be used to run other software such 
as word processing programs, spreadsheets, and desktop publishing software. 
 
Images can be printed using a 256-level gray scale thermal printer or any printer with a 
Windows® driver. The low-cost, high-quality prints are ideal for record keeping in lab 
notebooks or for publication.  
 
Images can be archived to the system’s hard disk, floppy disk, Zip or optional Jazz drive, 
or to a network drive if applicable. 
 
In section 1.4, there is a condensed instruction sheet, which will be useful if you are 
familiar with the program but need to quickly refresh your memory.  We suggest you 
photocopy the appropriate instruction sheet(s) and post them near the instrument for easy 
reference. 
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1.1.1 Mouse Functions 
The mouse supplied with the ImageQuant System has two buttons. The left button is used 
to activate functions and otherwise make selections when using the software. In some 
cases, the right mouse button is used to recall or reactivate the function that was most 
recently assigned to the left button.   

1.1.2 About This Manual 
Throughout this manual, different fonts are used to indicate certain things: 
This font indicates the name of a button, a menu, or a function found in a menu. 
This font indicates an entry that is typed 
Letters of words found between < > refer to keys on the keyboard. 
 
NOTE: 
Notes will be used throughout the manual to inform on interesting points and 
provide useful hints. 
 
CAUTION: 
Cautions will be used to inform the reader of action that may have the potential to 
either harm the instrumentation or affect the quality of the data. 
 
WARNING: 
Warnings are used to provide special notice of actions that have the potential to 
cause harm to the operator. 

1.1.3 Starting ImageQuant Capture 
To start ImageQuant Capture from Windows, double-click the ImageQuant Capture icon 
on the windows desktop. 
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1.2  ImageQuant Imaging System Setup 
1.2.1 System Components 
The ImageQuant System includes: 
• High-performance, high resolution, CCD camera 
• Zoom lens 
• Computer with keyboard, mouse, and monitor 
• Windows operating system (preinstalled) 
• ImageQuant Capture image processing software (preinstalled and calibrated with 

computer and hardware system) 
• ImageQuant light cabinet with UV transilluminator and white light fold-down 

transilluminator and interference filter 
• (optional) wide-angle fast lens 
• (optional) epi-illuminating UV lights 
• (optional) printer 
 
Check the packing list included with the system to verify that all components have been 
received. 

1.2.2 System Placement 
As with all electrical instruments, the ImageQuant System should be located away from 
water, solvents, or corrosive materials, on a table or bench top that is dry and stable.  
Further, the system should be placed away from interfering electrical signals and 
magnetic fields.  If possible, a dedicated electrical outlet should be used to eliminate 
electrical interference from other instrumentation in your laboratory. 
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1.2.3 Cabinet Assembly 
When you remove the light cabinet from its shipping carton, it is already partially 
assembled. The camera mounting assembly is packed separately in the same container. 
The UV transilluminator and cabinet top are both packed in separate boxes.  Make sure 
you have received all the hardware before discarding the shipping carton. Start by placing 
the cabinet on a level flat surface, in a position where you can easily reach the top, front 
and back. 

Attaching the Camera to the Cabinet  
Take the following steps to attach the camera to the cabinet: 
 

1. Remove the camera and lens from the packaging and attach the lens to the 
camera. Attach the lens to the camera. 

 
2. Place the camera stand on its side. 

 
3. Holding the camera in your left hand, position it against the camera post so that 

the data and power sockets are next to the post. With your right hand, insert the 
camera fastening knob (with washer) from the other side of the post, then turn the 
knob clockwise until the camera is secured at the top end of the post. 

 
Important Note: The camera must be fastened at the extreme top end of the 
upper post to prevent damage to the filter wheel when the lens is fully 
extended (see illustration below).  

 
4. Place the foam rubber camera stand gasket in the cabinet over the location where 

the camera stand will be placed. 
 

5. Carefully lower the camera stand (with attached camera) through the top of the 
cabinet, placing it over the gasket and positioning the lens directly above the hole 
that leads to the filter wheel. When lowering the camera/stand assembly into the 
cabinet, make sure that the lens does not damage the filter wheel when it pokes 
through the aperture. 

 
6. Fasten the camera post to the top shelf of the cabinet using the screws that are 

provided.  

   
Camera stand, camera and 
fastening knob laid out on table. 
 

View showing correct 
location of camera: At top 
end of post. 

Completed camera/camera stand 
assembly, which then gets placed into 
the cabinet and fastened down. 
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Installing the UV Transilluminator 
Take the following steps to install the UV transilluminator (this is a box-shaped UV 
lighting apparatus that rests at the bottom of the cabinet): 
 

1. At the bottom of the cabinet, there is an extendable metal tray that is held in place 
by a single screw (this is to prevent the tray from being damaged during 
shipping). Start by removing this screw and then pulling the tray out so that it is 
fully extended. 

 
2. With the tray fully extended, re-insert the screw (This ensures that you will have 

the screw if you ever have to ship the unit and also prevent light coming through 
the threaded hole that seats the screw.)  

 
3. Note that the extended tray has four holes, which match the rubber legs on the 

transilluminator. Place the transilluminator on the tray so that its legs are firmly 
seated in these holes. 

 
4. Plug the power cord at the bottom of the cabinet into the socket at the back of the 

UV transilluminator. 
 
5. Push the tray back into the cabinet. 
 

 
 

Close-up of the slide-out tray 
at the bottom of the cabinet. 
Note that there is a screw that 
holds the tray in place for 
shipping. Remove this screw 
to allow the tray to slide freely. 

 
 

Once the tray is extended, 
replace the locking screw in its 
original position. This will 
prevent light from entering into 
the cabinet through the 
threaded hole. 

 
 
Place the UV transilluminator 
on the tray (making sure that 
its rubber “feet” are firmly 
seated in the holes on the 
tray) and then plug the 
cabinet’s power cord into the 
back of the transilluminator.  
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Unfastening the Fold-Down White Light Tray 
The cabinet contains a fold-down light tray that is locked for shipping (see illustration 
below). Take the following steps to unfasten the light tray: 
 

1. The light tray is held in place by a detachable knob that screws into place just 
above the light tray. Unscrew the knob until it is separated from the cabinet 
and the tray can move freely.  

 
2. Note the bottom of the tray has a threaded hole. Insert the knob into this hole 

and turn it clockwise until it is firmly seated. 
 

 
 
Close-up of the fold-down 
white light tray located at the 
back of the cabinet. This tray 
is secured by a detachable 
knob. 

 
 
Release the white light tray by 
unscrewing the knob, which 
will allow the tray to swing 
down freely. 

 
 
Once the tray is released, 
screw the knob back into the 
threaded hole underneath the 
light tray, where it will serve as 
a handle.  
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Attaching the Hood 
Take the following steps to attach the cabinet hood and connect the hood fan:   
 
1. Place the hood on top of the cabinet so the holes for screws are centered over the 

corresponding holes in the top of the cabinet. 
 
2. From within the cabinet, attach the hood fan’s power cord to the temperature board 

socket on the top- right side of the cabinet.  
 
3. Fasten the hood to the cabinet using M4x16 socket head screws. 
 

 
 

The cabinet hood is positioned 
over the top of the cabinet 

 
 

Once the hood is positioned over 
the top of the cabinet, plug the 
fan cable into the socket on the 
top-right side of cabinet. 
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1.2.4 Cable Connections 
The Cable ends and the ports into which they are inserted are keyed or unique for each 
connection to eliminate confusion.  The connections are pictured and described in the 
next few sections. 
 
WARNING 
Make sure the power is OFF and all power cords are disconnected while connecting 
the cables and setting up the instrument. 
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1.3 Computer, Camera and Peripheral Installation  
All software, peripheral drivers and operating systems have been pre-installed at the 
factory.  During the system installation all components should only need to be plugged 
into the correct ports 

1.3.1 Setting up the Power Strip/Surge Protector 
Turn the power switch on the power strip/surge protector off.  Plug the power strip/surge 
protector into a wall outlet (preferably a dedicated circuit) and then turn the power on.   
 
CAUTION: 
Do not plug the light cabinet into the same power strip as the PC. Use a separate 
circuit if possible.  The cabinet needs to be turned on after the operating system has 
been completely loaded in order for the software to function optimally.   
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1.3.2 Setting up the Computer, Monitor, Mouse and Keyboard 
The computer will need to have the 
monitor, mouse and keyboard 
connected to it in the correct ports 
(see the descriptions below).  Also, 
a 3 prong standard power cable 
should be plugged into the back of 
the computer and the power strip. 
 
Connect the monitor’s video cable 
to the monitor port on the back of 
the computer.  If after-market video 
cards were preinstalled into your 
computer system connect 
the monitor’s video cable to 
the video card connector.  
Connect the monitor’s power cable 
to the power strip. 
 
The mouse and keyboard connectors 
are color-coded and icon identified.  
Attach the mouse and keyboard 
cables to the connectors on the back 
of the computer by matching the 
colors. 
 
The computer is now ready to be 
turned on.  Turn the computer on by 
pushing the power button on the 
front of the unit. 
 

 
 
 

COM1 port for DE-
500 Light Cabinet 

Keyboard/Mouse 
connections (color 
coded purple and 
green 

LPT1 port 
for parallel 
port printers 

Monitor Port 

USB ports 
for printers 
and other 
devices 
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1.3.3 Camera Installation 
 
Make sure that the power supply is set to the off ( o ) position before beginning the 
camera installation.   
 
1. Connect the data cable and power supply barrel connector to the top of the camera.   
 

 
 

Complete the camera connection by attaching the other end of the Data Cable to the 
computer interface card that came preinstalled in the computer system. 

 

 
 
2. Connect the standard three-prong end to the power strip. 
 

Power Supply  
Barrel Connector 

Data Cable 
connects here

Connect the Data Cable to the 
D-shaped connector on the 
computer interface card 

Data Cable 
from camera Computer 

interface card 
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3. Turn the power on to the camera by pushing the switch to the on position (│) 

 
Note: The camera should be turned off at the end of every day with all of the 
equipment by pushing the switch into the off position ( o ), or, by turning off the 
power strip. 

1.3.4 Connecting the Printer 
The Mitsubishi P91DW (UB) printer connections are color coded for convenience (see 
figure on previous page).  Plug the USB cable into the back of the printer and into the 
proper USB connector on the back of the computer.  Plug in the standard 3 prong power 
cable to the back of the printer and to the power strip, then turn the power on. 
 
Note: The Mitsubishi P91DW (UB) printer may be connected to any USB port on the 
computer; however, the driver may need to be manually reinstalled.  
 
The Mitsubishi CP700 and CP770 printers connect via the on-board parallel (LPT1) port.  
Plug in the standard 3 prong power cable on the back of the printer and into the power 
strip, then turn the power on.  Set the printer up for color or black and white printing 
following the directions in the owner’s manual supplied with the printer. 

Standard 3 prong 
power cord 

Barrel connector 
from step #1 
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1.3.5 Connecting the Cabinet 
The cabinet connects to the back of the computer via an RS232 cable. 
  
 
 
 
  
 
 
 
 
 
 
 
 
 
  
 
 

Ports on the back of the cabinet and computer respectively. 
 
Power on the cabinet after the Windows operating system has fully loaded.  The 
ImageQuant Imaging System is now ready for use. 

1.3.6 Starting ImageQuant Capture 
To start ImageQuant Capture from Windows, double-click the ImageQuant icon on the 
windows desktop. 
 

 
 
 
 
 
 
 

Connector on the 
back of the cabinet 

Connector on the back 
of the computer 
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1.4 ImageQuant System Quick Guide 
Note: This is intended as a quick reference guide for acquisition.  For more detailed 
information on the individual features reference section 1.6 of this manual. 

1. Power on the system:  
a. Turn on the computer, monitor, and optional printer. 
b. After the computer has booted up completely to the Windows 

desktop, turn on the power to the cabinet.  
c. Activate ImageQuant Capture by double clicking on the desktop 

icon.    
2. Positioning and Focusing on the Sample:   

a. In the ‘Tool Bar’, select the ‘Acquire’ icon to activate the image 
acquisition software features. 

b. In the Image Acquisition window, select the  button. 
c. Open the door to the cabinet and position your sample on the preferred 

illumination source.   Fluorescence samples that require epi or transillumination 
of UV energy should be placed on the purple UV filter glass.  For colorimetric 
samples such as protein gels, film, or blots, use the fold-down the white light 
table for your sample.  For chemiluminescence use the fold down white light 
table, or, the adjustable tray if used in conjunction with the fast lens. 

d. Open the aperture on the camera lens all the way open to the smallest number. 
e. With the door still open to allow light to enter into the cabinet, use the monitor 

real time readout display to position and focus your sample in the middle of the 
image acquisition window. 

f. Focus on the object.  For fluorescence and chemiluminescence if there is too 
much light to obtain a good focus setting, use the door to the cabinet to adjust the 
amount of light that enters into the cabinet.  Do not adjust the aperture to do this.  
For colorimetric samples it is necessary to decrease the aperture to acquire the 
image. 

Hint: Business cards and other pieces of paper with small text often are the 
easiest objects to obtain optimal focus settings with.   
g. If using a zoom lens, adjust the zoom setting so that the area of interest on the 

sample takes up all of the image size on the screen.   
3. Capturing a bright sample like fluorescently labeled gels, colorimetric samples and film: 

a. Close the cabinet door. 
b. Choose the appropriate optical filter for your sample type: 

a. Position #1 for colorimetric gels and film (no filter) 
b. Position #2 for ethidium bromide gels 
c. Positions #3-5 for other fluorescently labeled gels (optional filters). 

c. Turn on the illumination source (UV or white light) using the touch panel or 
‘virtual’ software controls. 

d. Select the  button.   
e. Select  
f. Select .  
g. Select the  resolution setting 
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h. Once the image in the preview does not contain any saturation (red false color 

palette for white bands, green for dark bands) select .  The exposure 
bar will turn green when this is complete.  If the exposure bar is pink in color, 
saturation is still present in the image.  For really bright images, particularly in 
white light applications, it may be necessary to reduce the aperture setting until 
the saturation is removed from the image. 

4. Capturing a low light image (like chemiluminescence) 
a. Close the cabinet door (there should not be any lights on in the cabinet). 
b. Choose Position #1 in the filter wheel for no filter. 

c. Select the  button. 
d. Select  
e. Select  
f. Select   
g. Select the  resolution setting  
h. Wait for the exposure bar to indicate that the proper exposure time has been 

found and that there is no saturation in the image - the exposure bar will turn 
green when this is complete.  If the exposure bar is pink in color, saturation is 
still present in the image.   

i. Select  resolution. 

j. Select . 
Note: The exposure time will vary depending on which resolution setting is selected in step 
4.h.  If the exposure time calculated by the auto expose setting is too long, it is possible to 
select the  or  setting instead.  Alternatively, if the exposure time 
is short enough,  may be selected for a full resolution (4 million pixels) 
chemiluminescent image. 

5. Save the original image 
a. Click on the Save Image function in the FILE menu or click on the SAVE or 

SAVE AS icon in the Tool Bar window. 
b. Enter a file name and select the directory to which it should be saved (the 

directory path should be less than 100 characters). 
c. Specify the file format (TIF, BMP, PCX, MAC, color TGA)  
d. Click OK to save the file 

6. Enhance the display [optional] 
a. Adjust the black, white and gamma levels by moving the slider bars at the right 

of the image in the “Contrast Adjust” window, or select auto contrast. 
b. Apply digital filters, found in the Tool Box under ENHANCEMENT and 

FILTERS (to stop a filter, hit any key on the keyboard; to reverse the effects of a 
filter, click UNDO). 

c. Add text, boxes, arrows, etc. to the image using the annotation tools in the Tool 
Box window under ENHANCEMENT and ANNOTATE. 

7. Print the image using the large PRINT button in the Tool Bar window or the pull-down 
FILE menu option 

8. Analyze the sample by using the analysis options in the toolbar (1D, Array, Colony and 
Toolbox). When one of these buttons is pressed, the image is transferred to the 
appropriate ImageQuant TL module for analysis.  
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1.4.1 Cabinet Controls 
 

 

Transillumination Controls 
These two buttons are used to toggle the UV transilluminator and the 
reflective white light table on and off.  

  

 

Reflective Light Controls 
These two buttons are used to toggle the reflective UV and white 
light sources on and off. 

  

 

UV Override Button 
Normally, if UV light is being used the cabinet automatically shuts 
off the UV light source when the cabinet is opened. This button can 
be used to override this behavior (the button should be held down 5-
7 seconds before opening the cabinet). 

  

 

Filter Wheel Position 
These controls are used to set the filter that will be utilized for 
acquisition. Use the arrow buttons to cycle through the available 
filter settings. The LED indicates the number of the filter that is 
currently being used: 
 
1 No filter – use for colorimetric gels and film. 
2 Ethidium Bromide 
3-5 Optional filters 
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1.5 System Information 
To display system information, select the About option in the Help menu.  This button 
accesses a pop-up box. 
 

 
 

ABOUT Pop-Up Dialog 
 
This box shows the instrument serial number (where appropriate) and the software 
version number.  Use the information specific to your instrument and software when 
calling for technical support, software upgrades, etc. 
 
To close the dialog box, click on the OK button. 
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1.6 Acquiring an Image 
In the TOOL BAR window, click on the Camera Acquire icon:   
 
Once the Camera Acquire Icon is pressed, the CAMERA SETUP AND REVIEW 
window is activated to provide exposure control of the camera, sensitivity/resolution 
controls, all lighting and filter wheel position controls, contrast display options and 
cabinet door open/close indicator using a software ‘virtual control’ menu.  Also, 
FrameGrabber setup is controlled and activated from this window.  This window will 
open with the Setup control mode activated (left button), which provides a near real time 
readout to allow for easy sample positioning and optics adjustments. 
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1.6.1 Focusing on an Image 
Focusing on an image in the ImageQuant Capture is easy with the real time display.  
Simply adjust the parameters on the manual lens, or, if the lens is controlled via the 
software, click on the appropriate software control button.   
 

1) To open the aperture, turn the 
lens's aperture ring counter-
clockwise for more light.  
Conversely, if the image is too 
bright, close the aperture by 
turning it clockwise until an 
image is visible on the 
monitor.  

 
2) Then, zoom in on the image so 

that the area of interest on the 
sample takes up the entire 
field of view on the screen.   

 
3) Last, if the image appears 

blurry, turn the focusing ring 
(lower ring on the lens) until 
the sharpest image is obtained. 

 
Note: This protocol may vary 
slightly with different accessory 
lenses.  For example, the fast lens 
may have an aperture setting of 
F1.8 and will not have a zoom ring. 
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1.6.2 Auto Exposure and Auto Exposure Setup 
The acquisition window for the ImageQuant Capture includes a check box and setup 
button for Auto Exposure. 
 
          
 
 
 
 
 
 

Auto Exposure Setup options.  Click 
this button to view and Edit Auto 
Exposure settings.   



ImageQuant 400 User Manual 

  
21 

Auto Exposure Setup (Auto Exposure Compensation Setting): 
4 choices available 

• Normal Exposure for image saturation:  Use this choice for normal 
Colorimetric and Fluorescent imaging. 

• Under Exposure for chemiluminescence 
• Over Exposure for faint band detection. 
• Custom Exposure Compensation:  user definable Exposure Value (EV). 

 
The up/down arrows allow the user to change the EV value by whole units (left up/down 
arrows) or by 1/8th (right up/down arrows). 
 
Auto Exposure works in both “Preview” and “Capture” modes.  As the software 
calculates the correct exposure time you will see the status bar change from red to yellow 
and then to green.  When it reaches green the software has achieved the correct exposure 
time.  If the bar turns pink, this is an indication that there are saturated pixels in the image 
area at the exposure time calculated.   
 
In Capture mode the image will be acquired when the bar turns green.  In Preview mode 
the software will continue exposing over and over at that exposure time until a different 
mode is selected.  If “Capture” is selected after the software has achieved the correct 
exposure time in Preview mode the software will begin acquiring at the last exposure 
time calculated in Preview mode—it does not start the calculation over from scratch.  
Similarly, if a different sensitivity (binning) mode is selected after the exposure 
calculation has been calculated, it will do a quick conversion and does not have to start 
the calculation from scratch. 
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1.6.3 Cabinet Controls - Activating the Light Source and 
Selecting a Filter 

Use the mouse to click on the desired light source in the ‘virtual’ cabinet control interface 
or you can use the controls on the cabinet itself.  Both mechanical and software controls 
are linked and communicate display setting selections.   
 
Note: There is a slight delay when the button is depressed until the light source is 
fully activated.   
 
Standard lighting choices include: 
 
 Transillumination White: For protein gels, autorads, film, plates, flasks  
 Transillumination UV: For fluorescent gels such EtBr, SYPRO® Red, etc. 
 Reflective White:  For colorimetric blots and membranes 

Reflective UV (optional) For SYBR® green, TLC plates, and 
Chemifluorescence 

 (No Light Selected)  For chemiluminescence 

You can also select your FILTER to correspond with your sample staining.  The 
options include: 
 
 Filter Position #1:   Chemiluminescence samples, no filter 

Filter Position #2: Ethidium Bromide, colorimetric stains, film, 
SYPRO® Orange (595nm) 

 Filter Position #3 (optional): SYBR® green (557nm) 
 Filter Position #4 (optional): Fluorescein, SYBR® Gold (520nm) 
 Filter Position #5 (optional): SYPRO® Red, Texas Red (630nm) 
 (optional): Hoechst Blue (460nm) 
 
Note:  Each Filter has an approximate bandwidth of +/- 40nm to allow for use with 
other fluorescence stains as they are developed.   
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1.6.4 Sensitivity/Resolution Settings 
The ImageQuant System allows you to acquire images depending on your critical needs.  
Are you looking for the shortest possible acquisition time, the highest resolution, or a 
combination of both?  Acquisition modes: 
 
Normal Sensitivity/High Resolution  
Recommend for Fluorescence and Colorimetric Imaging.  This mode captures the image 
using the CCD sensors full 2048x2048 pixel resolution to generate high quality, vibrant 
images that are publication quality. 
 
Medium Sensitivity/Medium Resolution 
Recommend for Chemiluminescence.  This mode captures the image performing a 2x2 
pixel bin to decrease the exposure time of the image, yet still maintain a publication 
quality 1024x1024 pixel resolution image.  Medium/Medium sensitivity selection will 
decrease the exposure time needed over a full resolution image by approximately 4X. 
 
High Sensitivity/Medium Resolution 
Recommend for Chemiluminescence.  This mode captures the image performing a 2x2 
pixel bin with a gain setting of 3 to further decrease exposure times and still maintain a 
publication quality 1024x1024 pixel resolution image.  The High/Medium sensitivity 
selection will decrease the exposure time needed by about 2X over the Medium/Medium 
selection. 
 
High Sensitivity / Low Resolution  
Recommend for Chemiluminescence.  This mode captures the image performing a 3x3 
pixel bin with a gain setting of 3.  This will decrease the exposure time needed by 
approximately 2X over the High/Medium setting but yield a lower resolution image 
containing 682x682 pixels.  This mode is ideal for high throughput screen applications 
for verification of absence or presence of target DNA or Protein. 
 
Super Sensitivity / Low Resolution  
Recommend for Chemiluminescence.  This mode captures the image performing an 8x8 
pixel bin with a gain setting of 3.  This will significantly decrease the exposure time 
required for acquiring a long chemiluminescent exposure by about 2X over the High/Low 
setting or 8X over the Medium/Medium setting.  The resolution using this mode is 
256x256 pixels and is not recommended for publications.  This mode is ideal for 
previewing when using auto-expose to determine the signal level in the 
chemiluminescent blot.  It is also ideal for high throughput screen applications for 
verification of absence or presence of target DNA or Protein.   
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1.6.5 Use Preview to Set Exposure Time 
Once the sample has been positioned and the camera has been focused, close the door to 
the ImageQuant light cabinet and make sure that the appropriate illumination source is 
turned on. Also make sure the cabinet door indicator in the Cabinet Control software 
interface indicates CLOSED. 
 
Click on the blue PREVIEW button and select the desired exposure time in the menu 
options to give the desired image intensity quality.  Individual adjustments for 1/30 
seconds, seconds, minutes, and hours are available.   
 

• For most white-light applications, a 50 millisecond exposure is sufficient with 
final adjustments of the aperture for best image quality.  

 
• For UV fluorescence applications, usually a 250 millisecond to 4 seconds is 

sufficient and the aperture should be adjusted fully open.  The ‘show 
saturation’ option should be selected for these applications. 

 
• For low-light applications, such as chemiluminescence, a longer exposure 

time may be appropriate and it is best to go to the ACQUIRE button to 
directly acquire the image once the desired exposure time is set.  
Alternatively, if a good exposure time is unknown, try selecting Auto-Expose 
and using the super sensitivity selection.  Auto-Expose will generate an image 
showing the signal intensity usually in less than 3 minutes.  Afterwards, a 
different sensitivity (binning) mode can be selected to generate a better 
resolution image and the software will automatically calculate the new 
exposure time for you. 

 
Note:  When the system is switched to PREVIEW mode, the image may flash or 
change brightness because the camera collects photons from the image for a longer 
period of time before sending the image to the computer’s display readout. 
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1.6.6 Optimizing the Gray Scale for Saturation and Contrast 
Displays 

 

 
 
If an image will be analyzed, it is important that it not be over-saturated (too light) or 
under-exposed (too dark). Using Show Saturation, the user can see the areas of the 
image that are assigned to each end of the gray scale spectrum, and can adjust the 
imaging controls accordingly. 
 
The Show Saturation checkbox (found below the camera control functions) allows the 
user to access the Saturation Palette during image acquisition.  The Saturation Palette 
is a modified gray scale palette in which black (gray level 0) is replaced with green, and 
white (gray level 255, 4,095, or 65,535) is replaced with red.  With this palette, over- and 
under-exposed areas of the image are shown as green or red, while areas within the linear 
range of the CCD chip are shown in gray scale.   
 
During image acquisition, note regions of the image that appear red or green.  Adjust the 
exposure time and/or the camera aperture to minimize the amount of red and green in the 
image area.  If an image will be quantified, it is especially important that the actual 
sample area be neither red nor green.  Once you are satisfied with the displayed image, 
you may click off the Show Saturation.   
 
The other three selections Chemi Display, Auto Contrast, and Reverse are 
visualization tools designed to enhance contrast and provide flexibility in regards to how 
the user wishes to view the image. Auto Contrast will display the image with automatic 
black, white and gamma adjustments according to the image histogram information 
(black/white levels). Reverse will show the sample as a negative by switching the black 
and white values.  Chemi Display utilizes both the auto contrast and reverse functions as 
well as adjusting for gamma.  It is intended for use with chemiluminescent samples.  
These options are also available in the FrameGrabber portion of the acquisition software. 
It is important to note that these Contrast Display options are only visualization tools and 
are NOT changing the image data that is being acquired by the CCD camera. 
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1.6.7 Extended OD Acquisition Feature 
Extended OD is a process that delivers Full Dynamic Range Performance for digital 
imaging applications.  Extended OD acquisition accomplishes this by extending the range 
of different light (or brightness) levels from the sample that can be viewed as a single 
image beyond that of a standard image.  Extended OD acquisition can produce an image 
that represents more than 100-fold extension of the brightness range.   

In the TOOLBAR window, click on the Camera Acquire icon:   
 
The Camera Setup and Preview window appears. 
 

 
 
This window contains an Extended OD slider bar located to the left.  
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Acquiring in Extended OD Acquisition Mode 
The user may acquire a Extended OD image with a factor from 2 to 500.  Choose the 
Extended OD factor to use by sliding the Extended OD slider bar to the right.  Extended 
OD acquisition is activated whenever the Extended OD slider is in any position other 
than “Off”.  As the slider bar is moved to the right the “Extended OD Factor” will 
increase and be displayed.   
 

 
 

In addition to the Extended OD Factor, the software also shows a time estimate for the 
total acquisition time.  This time estimate is displayed as “Time x ‘value’” where ‘Time’ 
is the initial exposure time (see below) and the ‘value’ is the multiplier to achieve the 
chosen Extended OD Factor.  In the example above the Factor is set to 8.  The total 
acquisition time will be 544 times the initial exposure time.  If the initial exposure time is 
10 milliseconds, the total acquisition time for this acquisition will be 10 milliseconds x 
544 = 5440 milliseconds or 5.44 seconds. 
 
Initial Exposure Time for Extended OD Acquisition 
Whenever Extended OD is activated the acquisition interface disables the exposure time 
input fields and switches to Auto Exposure mode.  The initial exposure time used for 
Extended OD is determined by a proprietary Auto Exposure algorithm.  Clicking the 
Preview button in Extended OD mode will calculate and display the initial exposure time.  
Clicking the Acquire button in Extended OD mode will start the Extended OD 
acquisition process which first determines the initial exposure value and then performs 
the Extended OD acquisition process automatically. 
 
Acquiring Extended OD Images 
Slide the Extended OD slider bar to the desired Extended OD factor.  Click the Acquire 
button.  When the process is complete the resultant Extended OD image will be displayed 
in the ImageQuant Capture main window. 
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Canceling/Stopping the Extended OD Acquisition Process 
During the Extended OD Acquisition you may want to cancel the process or stop the 
process and save the resultant image.   
 

 
 

Click the Cancel Button to cancel the process and return to the acquisition window.  
Otherwise select the “Stop and Save” button.  The resultant image will be displayed as it 
appears at that point in the acquisition process.   
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1.6.8 Using the Zoom ROI Tool 
Zoom ROI is a tool that is designed to be used with a fast or fixed focal length lens.  
These lenses typically have lower F stop numbers than zoom lenses but do not contain a 
zoom function.  Fast lenses are most commonly used for chemiluminescence to decrease 
exposure times. However, they can also be used for fluorescent gels and other 
applications as well.  Since there is not a zoom ring on a fixed focal length lens, it is now 
possible to adjust the region of interest of the acquired image using the ImageQuant 
Capture interface. 
 
When the region of interest of the sample is smaller than the acquisition window, and the 
system is not equipped with a zoom lens, the zoom ROI tool is the ideal work around 
without having to switch lenses on the system.  Focus on the image as explained in 1.4 
and 1.6 of the manual and then slide the zoom ROI slider across the screen until the 
region of interest occupies the entire image area in the acquisition window.  Use the 
Preview and Capture buttons to acquire the final image.  This eliminates a post-
acquisition step of cropping the image down to the appropriate size. 
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1.6.9 Acquiring a Standard Image (Without Extended OD) 
ImageQuant Capture is capable of acquiring images in standard mode (single image 
exposure) and in Extended OD mode.  To acquire a standard image slide the Extended 
OD slider bar to the far left until the display shows “Extended OD: Off”.  Clicking the 
Acquire button with Extended OD acquisition turned off will acquire a standard image 
according to the exposure time set by the user, or by Auto Exposure if chosen. 

1.6.10 Acquire and Transfer the Image 
Once the appropriate image is displayed on the screen, click on the ACQUIRE button to 
capture and display the image in ImageQuant Capture. The acquired image will be 
automatically adjusted by a zoom factor based on the resolution setting to display the 
image optimally. From there, the image can be enhanced using ImageQuant’s 
enhancement tools and/or transferred to an ImageQuant TL module for analysis. 
 
Once a satisfactory image has been captured, we suggest saving it as an original file.  
However, if you do not save before transferring the image to an ImageQuant TL module 
for analysis then you will be prompted to save as part of the transfer process.  
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1.6.11   Capturing Images Using FrameGrabber Mode 
If kinetic, multiplex, color, or chemiluminescence experiments are desired where you 
wish to have the system automatically capture several images at preset exposure times, 
preset time delay between images, preset lighting sources, and preset filter choices, the 
FRAMEGRABBER tab can be clicked in the Tool Box. (FrameGrabber is also 
accessible in camera setup acquisition screen.  To access this screen select the acquire 
button on the tool bar and then select ‘FrameGrabber’ on the acquisition screen: 
 
                                   

    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FrameGrabber button in 
the camera setup 
acquisition screen 

FrameGrabber Setup in the Tool Box 
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Once FRAMEGRABBER is selected, a display box will appear for independent control 
of all lighting, filters, and exposure delay for each image frame. 
 
The TOTAL FRAMES setup provides you with 
the ability to determine how many individual 
frames (images) you want for the sequence.  
There is a maximum of 50 frames (images) and a 
minimum of 1 frame that can be captured with 
each sequence.   
 
The FRAME selection is used for setting up the 
conditions for each frame (image).  For example, 
if three (3) images are to be captured, you would 
choose FRAME 1 and setup all of the desired 
lighting and filter requirements.  You can then 
click on FRAME 2 and repeat the above.  Or, you 
can click on COPY TO NEXT to help speed up 
the setup process.  COPY TO NEXT copies all 
settings from the previous frame to the current 
frame.  Usually, for chemiluminescence imaging, 
all lighting is off and the filter wheel is positioned 
for the chemiluminescence position for all 
frames.  Thus, the only variable that is changing 
from one frame to the next is the exposure time.  
In this situation, COPY TO NEXT is a useful 
tool to save time in the setup process. 
 
If you are performing kinetic experiments where 
you want to have a predetermined delay between 
captured images, then you can use EXP DELAY 
to configure this function.  The default EXP 
DELAY is set for the shortest possible delay (19 
milliseconds), but can be configured up to 50 minutes between each image.  Also, if your 
exposure delay and/or exposure time and/or lighting options/filter position are consistent 
for the entire sequence, then once you set up the first frame, you can select the COPY 
TO END selection to automatically choose the first frame settings for the entire sequence 
of frames (images). 
 
Once the sequence is set up to the desired configuration, click on the GO button.  The 
software will then begin the process of image acquisition for each frame of the image. 
When it is complete, the Camera Setup and Preview window will disappear and the 
TOOL BOX will automatically display the FrameGrabber tab.  This will allow you to 
play back the sequence, save or load the sequence, or record a new sequence. 
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Once all images have been captured, the FrameGrabber tab will become displayed in the 
Tool Box.  The buttons on this tab perform the following tasks: 
 
REC Opens the Camera Setup and Preview window to record a 

sequence. 
PLAY   Display a continuous loop of all of the captured images. 
STOP   Stop the sequence at the current frame display 
PAUSE  Pause the playback of the sequence at a user defined image 
REW (rewind) Rewind the sequence to the first image 
REV (reverse)  Play the sequence in a continuous loop in reverse 
FWD (forward) Moves forward in the sequence to the last image 
DEL (delete) Delete the sequence on the display.  THIS FUNCTION WILL 

NOT DELETE A SEQUENCE SAVED TO THE HARD DRIVE. 
LOAD Load a previously saved sequence.  THIS FUNCTION WILL NOT 

LOAD INDIVIDUAL IMAGES PREVIOUSLY CAPTURED IN 
NORMAL CAPTURE MODE. 

SAVE Save a sequence of images.   
 
 

1.6.12 Saving an Individual Image from a Sequence 
 
After you load, play, and stop a sequence at the desired image, it is possible to save the 
individual image seen on the screen.  Use the SAVE AS button located on the tool bar to 
save the image in the desired location and file format on the local or network drives.   

 
Note: This will save the current image only.  To save the entire sequence, 
select the ‘save’ icon on the FrameGrabber tab in the tool box. 
 

1.6.13 Loading/Saving an Entire Sequence 
 

You can load or save an entire sequence by using the load and save icons in 
the FrameGrabber tab in the tool box.  When a sequence is loaded, the loaded 
frames will be seen as blue in the frame reel.  When a sequence is saved, a 
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dialog box will appear prompting you to select the location and name for the sequence 
that you would like to save the images as. 

1.6.14 FrameGrabber:  Save/Load FrameGrabber Setup Routines 
 
Two buttons “Save Setup” and “Load Setup” allow you to save and load all 
FrameGrabber setup parameters.  Files are saved as *.mvf files. 
 

 

1.6.15 Frame Stacking 
At the top of the FrameGrabber setup window is an option for stacking frames. If this 
selection was chosen during acquisition of the image Stack Frames will use all previous 
exposure information to sequentially add images to one another.  Normal Sequence will 
not perform this addition.  Please note that stacking frames will increase the noise level in 
acquired images.    
 
 Sample case: 
  Capture 5 frames at 1-5 sec exposure for total time elapsed 15 sec 
  Display after summation of following frames: 

 Frame 1 (1 sec) 
      Frame 2 (1 + 2 sec) 
     Frame 3 (1 + 2 + 3 sec) 
     Frame 4 (1 + 2 + 3 + 4 sec) 

      Frame 5 (1 + 2 + 3 + 4 + 5 sec) 

Load Setup and 
Save Setup buttons 
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1.6.16 Capturing a Color Image Using the FrameGrabber 
Function 

A color image can be generated by acquiring three images each taken with a red, green 
and blue emission filter.  Once saved, these images are then combined in the Overlay 
pull down menu.  Open the image captured with each of the three filters as instructed and 
a RGB (red, green, blue) true color image will be generated. 
 
For color imaging, you will need to the following optional filters: 

 

 Red Filter SYPRO® Red Filter  (Catalog #:  63005664) 

 Blue Filter Hoechst Blue Filter  (Catalog #:  63005665) 

 Green Filter SYBR® Green Filter  (Catalog #:  63005661) 
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Chapter 2: Getting Started - Basic 
Imaging Functions 
 

2.1 Contrast Adjustment 
The Contrast Adjustment window allows for the best visualization possible of a sample 
utilizing the black, white, and gamma adjustments, as well as, image reverse and auto 
contrast.  

 
The image on the screen is made up of picture elements (pixels) in an array.  Each pixel 
is assigned a brightness (or a gray scale value) level between black and white. A very 
bright image has most of its pixels registering high gray level values and conversely, a 
very dark image has most pixels registering low gray level values (approaching zero). 
 
The distribution of these gray values to the image is determined by the Contrast 
Adjustment Controls.  These controls regulate the Black level, White level, and 
Gamma setting (brightness linearity), allowing adjustment of the display to obtain the 
best image possible.  
 
Note: These enhancement features modify the image display on the monitor only, 
and do not change the original quantitative data. 
 
ImageQuant Capture can also import RGB color images.  ImageQuant Capture 
automatically detects this process and the Contrast Adjustment tools are configured for 
color image adjustments. 
 
An image can be enhanced using these tools and then saved as a modified file for 
publications.  However, to preserve the original image information, it is recommended 
that the file be saved as a different file name when using the save modified. 
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2.1.1 Using the Contrast Adjustment Tools for Grayscale Images 
There are three sliding scales found in the image control area to the right of the image.  
Below each scale is a box displaying a number that corresponds to the position of the 
slider.  By adjusting these sliding scales, the image display can be optimized. 
 

 
 

Imaging Display Tools:  Black Level, White Level,  
Gamma Setting with B/W/G, Linear, Log, and Equalize options 

 
To adjust any of these settings, place the cursor on the slider. Click and hold down the 
left mouse button while dragging the slider to a new setting.  As the slider is moved along 
the scale, the image display is updated, along with the change in numeric value.  The 
arrows above and below the scale bars can also be clicked to change the settings in single 
unit increments, or, the user may type in a specific unit. 

2.1.2 Black Level Adjustment  
The number beneath the Black Level scale corresponds to a gray level.  There can be 
256, 4095 or 65,536 possible gray levels depending on the system type.  For the example 
below, an 8 bit image will be used with 256 total gray scale values.  When the Black 
slider is at the very top of the scale, the number is 0.  As the slider is moved downwards 
along the scale, the number increases and the image becomes progressively darker. This 
is because all pixels at the specified gray level and lower are shown on the screen as 
black pixels.  If the slider is set to 0, all the pixels whose gray levels are at 0 are shown as 
black. If the setting is then changed to 60, all the pixels between 0 and 60 are shown as 
black and the image appears darker. 
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 Black Level set at 0 Black Level set at 60 
 

2.1.3 White Level Adjustment 
The number beneath the White Level scale also corresponds to a gray scale value. When 
the slider is at the very bottom of the scale, this number is 255.  As the slider is moved 
upwards along the scale, the number decreases and the image becomes progressively 
lighter. This is because all pixels at the specified gray level value and above are shown on 
the screen as white pixels.  For example, if the slider is set to 150, all the pixels between 
150 and 255 are shown as white and the image appears lighter.    
 

   
 White Level set at 255 White Level set at 150 
 

2.1.4 Gamma Setting Adjustment 
Changing the Gamma setting affects the image brightness by adjusting the linearity of 
the image on the screen and printouts, but does not affect quantitative data.  
 
The camera sees objects linearly while the human eye does not. When the Gamma 
setting is set to a value of 1, the image is displayed as the camera sees it. This, however, 
is different from what the human eye detects.  By adjusting the Gamma setting, the user 
can make the image on the screen correspond to what is seen when he/she looks directly 
at the object.  We recommend a Gamma setting of 0.55 for best visual representation. 
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 Gamma set at 1.0 Gamma set at 0.55 
 
   
   

2.1.5 The Auto Contrast Selection 
The Auto Contrast feature will automatically scale the black and white values of an 
image to more tightly fit the gray scale intensity profiles (histogram).  This selection will 
use different black and white values for different images depending upon their unique 
histograms.  A more dramatic visual change will take place for low light level images 
(such as chemiluminescence) where smaller portions of the histogram are used.  This 
selection can be turned on or off and will adjust differently for each image.   
 



ImageQuant 400 User Manual 
 

 
 

 40 

2.1.6 The Reverse Button 
The Reverse button inverts the gray levels of the displayed image, converting a positive 
image to negative, or vice versa.  For instance, an image with black bands on a white 
background is converted into an image with white bands on a black background by 
simply clicking the Reverse button.  Clicking the button a second time returns the image 
to its original form. 
 

   
 Original Image Reversed Image 
 
 
Note:  Reversing an image changes the way it is displayed on the screen, but does 
not change the quantitative data.  For example, the bands in the above gel have the 
same density, regardless of whether the gel is displayed as white bands on a black 
background or black bands on a light background.  For information on reversing 
pixel values, see Invert option under Setup|Preferences.  
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2.1.7 The Grid Button  
The Grid button provides an on-screen grid after image acquisition to check for proper 
sample alignment. 
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2.1.8 Making Linear, Log, or Equal Adjustments 
Original image of film 
with default BWG settings 
 

 
Image of film with linear 
Contrast Adjustments 
selected. Linear provides 
minimum and maximum 
adjustment tools from 0 to 
100%.  Linear stretches 
the grayscale range of the 
displayed image to the 
maximum system dynamic 
range of 0-65,535 
grayscales. 

 
Image of film with log 
Contrast Adjustments 
selected. Log provides 
minimum and maximum 
adjustment tools from 0 to 
100%.  Log performs a 
logarithmic adjustment to 
the grayscale range of the 
displayed image. 

Image of film with equal 
Contrast Adjustment 
selected. Equal 
automatically adjusts the 
image display for 
maximum contrast which 
is beneficial for faint band 
detection.  



ImageQuant 400 User Manual 

  
43 

2.1.9 Using the Contrast Adjustment Tools for Color Images 
ImageQuant Capture can also import RGB color images.  The software automatically 
detects this process and the Contrast Adjustment tools are configured for color image 
adjustments. 
 

 
 

Contrast Adjustment display with Show thumbnail clicked for color image 
 
The Black, White, and Gamma bars can now be adjusted individually for each of the 
three RGB color channels by selecting on the Red, Green, or Blue button and making the 
appropriate B/W/G adjustments 
 
Also, by clicking on the Show thumbnail option, a thumbnail display of each of the 
three color channels is displayed.  These thumbnails also display any black, white, or 
gamma adjustments for each color channel. 
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2.2 Tool Bar 
The Tool Bar window provides intuitive buttons for the most common functions in 
ImageQuant Capture. 
 

 
 

Tool Bar 
 

The Open button functions identically to the File Open function in the 
upper menu bar.  This function is used to open previously saved images.  
Detailed instructions are available in Chapter 3. 
 
 
 
The Zoom Out and Zoom In buttons provide easy zooming ability while 
you are active in image enhancement functions providing increased 
versatility.  Detailed instructions are available in Chapter 4 as this function 
is also available in the Tool Box.   
 
Note:  The Status Bar always displays the image zoom setting in real 
time. 

 
 
The Saturation button allows for a quick image display of saturation.  
Completely saturated black regions (gray scale 0) will turn green and 
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saturated white regions (i.e. gray scale 255, 4095, 65,535) will turn red.  
This is a useful tool to check for linearity of an image before analysis 
occurs.  Saturation is a feature that is most important during the 
acquisition stages and is thoroughly detailed in the acquisition features of 
the system manuals. 

 
 
 
The Img Drag button is useful for to pan with a zoomed image.  To 
activate this function, click on the button and move the mouse cursor to 
the image.  The cursor will have changed to a small hand.  Click the left 
mouse button and drag to move the image.  When you are done, you can 
click the Img Drag button again to deactivate it.   
 
Note:  Img Drag is only active when the image is zoomed in beyond 
1X (greater than 100%).  The button is grayed out in other zoom 
modes. 

 
 
 
The Print button allows for quick and easy image printing with the active 
default printer.  Detailed instructions on image printing are available in 
Chapters 2 and 3 as printing can also be accomplished via traditional 
Windows File menu options. 
 
 
 
The Notepad button opens up a dialog box to allow the user to quickly 
track experimental conditions, comments, and any other details to be 
saved as an electronic copy for future reference. Detailed instructions are 
available in Chapter 3 as this Notepad function is duplicated in the 
Utilities function in the upper header bar. 
 
Clicking Reset returns the image to the system defaults as specified in the 
active default file.  This is detailed later in Chapter 3.4 of the manual. 
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Clear removes any overlays currently displayed on the image. This 
function can be useful if annotations or other displays obscure parts of the 
image. 

 

 
Once an image is displayed, it can be printed on the default printer by 
clicking the Print button in the Tool Bar window display.  Most printers 
can be configured through the Windows operating system to be the default 
printer.  Refer to your Windows operating manual for more information on 
installing a default printer. 

 

 
Sample Printouts 
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2.3 Tool Box 
The Tool Box window contains an intuitive interface for performing all image 
enhancement functions.  
 

 
Tool Box Display Window 

 
It contains controls for enhancing and adjusting the image.  This includes software 
filtering, false colors, zoom factors and other unique features.  The Tool Box options are 
detailed in chapter 4 of this manual. 

2.4 Status Bar 
The Status Bar is located on the bottom of the monitor and provides a real time display 
of the mouse cursor x, y position, the image zoom factor, and the grayscale intensity at 
the mouse cursor x, y position.  
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Chapter 3: Pull-Down Menus 
 
Across the top of the screen is a Windows menu bar containing several system operation 
functions.  These include file saving and loading, edit, image, setup, overlay, file utilities, 
view and help functions.   
 

 
 

ImageQuant Capture Menu Bar 
 

3.1 The File Menu 
Use this menu to save an image as a file, retrieve a previously saved image, select 
different printers, print an image to a parallel printer, overlay multiple images in RGB 
color channels, close an image, log-off of the system or exit the system.   
 

 
 

ImageQuant Capture File pull-down menu 
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3.1.1 File|Open   
 
This function opens an image that has been previously saved as a TIF, GLP, BMP, PCX, 
TGA, PIC, JPG or Macintosh® TIFF (MAC) file.  

 
File Open Dialog Box 

 
Using the left mouse button, click on the name of the file to be loaded. That name is then 
highlighted in the list and appears in the text box below the File Name prompt.  
 
Alternate disk drives can be accessed using the “Look In” dialog box. 
 
Once the file has been selected, click on the Open button to load the file. (Alternatively, 
double-click on the file name.)  The dialog box disappears and the selected image appears 
in the image window on the screen. 
 
To dismiss the dialog box without loading an image, click on the Cancel button. 
 
 
 



ImageQuant 400 User Manual 
 

 
 

 50 

 

3.1.2 File|Overlay 
 
 
To superimpose images, use the OVERLAY function under the File menu.  This function 
will display separate multiplexed images or a RGB color image as a compiled image with 
the appropriate color channel images added together.  A simple way to acquire multiple 
images for this function is to use the FrameGrabber function in image acquisition and 
acquire a series of identical images. 

 

The Overlay Images option allows you to overlay up to three different images with three 
different color channels.   You can select the BROWSE button for each color channel and 
select the appropriate images to be used for generating a color image.  For example, if 
you have a saved grayscale images of an identical gel taken with a SYPRO® red filter for 
the red stain and a SYBR® green filter for the green stain, you can choose these images 
in the appropriate Red and Green Channels to generate a composite image with the red 
and green colors mapped onto the compiled image.  
 
Note: The images must be the same bit depth and resolution for the software to 
overlay the images. 

3.1.3 File|Close 
This function closes the image currently displayed on the screen. 
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3.1.4 File|Save and Save As  
Save allows original images to be saved in several different formats.  Save As allows 
images that have previously been saved to be saved in a different location or as a 
different file type without affecting the original image. 
 
ImageQuant Capture has the ability to save files in several formats, see the following 
figure: 
 

 
 
Enter a new file name in the text box adjacent to the File Name prompt.  Next, choose a 
file type from the Save As Type list.   
 
ImageQuant Capture will automatically give the appropriate 3-character extension.  
ImageQuant Capture will also create a file with the same base name and an .STP 
extension.  This setup file saves information specific to this file, such as Black Level, 
White Level, Gamma Setting and 1D-Multi template placement.  If the file is accessed 
later, these settings will be recalled. 
 
 
 
 
 

File Formats:   

*.tif, *.bmp, *.glp, *.pcx, *.tga, 
*.pic, *.jpg, *.mac, 
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File Types 
TIFF is the default file format for ImageQuant Capture files.  TIFF is an acronym for 
"tagged image file format" and was developed as a flexible and machine-independent 
graphic file format.  Saving as a TIFF file will allow users to double-click TIFF files 
from Windows Explorer and automatically launch the application on any machine that 
has ImageQuant Capture loaded on it.  Users may customize this in the preferences 
section covered in section 3.4 of the manual if they wish to change the default file type.   
 
Mac TIFF is the Apple Macintosh® version of the TIFF file format. Mac TIFF files have 
the extension .MAC so they can be easily distinguished from Windows TIFF files. Most 
software can distinguish between Mac and Windows TIFF formats and can accept either. 
ImageQuant Capture offers the option of both formats in the event that only one of the 
two is acceptable. 
 
GLP is a proprietary file format that allows changes to only be made in ImageQuant 
Capture programs.  It will accept 8 bit and 16 bit images and can not be opened in any 
other software program.  
 
BMP, PCX, TGA, PIC, JPG, GLP are additional graphic file formats which may be 
useful when saving an image for desktop publishing.  These file formats can be imported 
directly into many Macintosh® and PC programs.  (See Appendix A for more 
information.) Do not use these formats to save images that will be analyzed later, since 
pixel data can be lost or altered when saving files in these formats.  
 
Note: Not all of the file types listed above can be saved as a 16 bit file.  Some may 
require you to convert the image to an 8 bit file first.  

Original versus Modified Files 
An Original image file is one in which the data is saved in an unaltered form.  This 
option should be selected if the image will be analyzed later. If the Black level, White 
level, or Gamma settings have been adjusted, the new values are saved but the pixel 
values are not altered.  When this file is opened at a later time, ImageQuant will display 
it with the values that were displayed when the image was saved, however, it is still 
possible to revert to the original raw image file by selecting Reset on the Tool Bar . 
 
Annotation information cannot be saved with the Original image option. (It can, 
however, be saved as an Overlay.   
 
If an image is saved as a Modified file, it permanently retains any changes made to the 
Black level, White level, and Gamma setting.  Annotations and any filtering performed 
are also saved with the image, replacing original image information with the new 
information.   
 
Note:  If the image is saved as a Modified file it is converted to an 8-bit image.   
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3.1.5 Printer Setup 
 
This function displays a dialog box in which the settings for the parallel printer are 
specified. When all the pertinent printing preferences have been specified, click on the 
OK button.  If you purchased a printer with ImageQuant, this will be preset from the 
factory. 
 

Printer Setup Dialog Box Printer…. Dialog Box 

      
For more information on using the Print menu, see the Windows manual. 
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3.1.6 Print  
This function sends the image to the default printer specified in Print Setup. 

3.1.7 Logoff 
This function logs the current user out of ImageQuant Capture when security features are 
in use.   

3.1.8 The Exit Function 
The Exit function closes ImageQuant Capture. To restart ImageQuant Capture from 
Windows, double-click on the ImageQuant Capture icon on the desktop. 
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3.2 The Edit Menu 
 
The Edit menu provides the ability to copy, crop and remove any annotations or filters 
that have been added to the original image.  
 

 
 

Edit pull-down menu 
 
To activate the Copy and Crop functionality, place a check mark next to EDIT 
ACTIVATION.  This will turn the mouse cursor into a + sign that will allow you to 
highlight the region of interest for the image.  After Edit Activation is highlighted, the 
desired area of interest is drawn using the mouse.  
 

 
 

Ready to Crop or Copy 
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Once this is completed, you can select either the COPY or CROP function in the EDIT 
menu options.   COPY will copy the desired area of interest into the Windows Clipboard 
and allow you to paste into any desktop publishing package (i.e., Word, Excel, Adobe 
Photoshop, etc.).  CROP will display just the region of interest as the active window in 
the ImageQuant Capture interface. 
 

 
 

ImageQuant Capture interface after cropped region has been selected 

 

3.2.1 Reset and Clear 
The Reset option configures the Black, White, and Gamma settings to default settings. 
Clear removes any annotations that are present on the image. 
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3.3 The Image Menu 
The Image menu option provides the ability to perform a variety of image processing 
functions. 

 
 

Image pull-down menu 

3.3.1 Equalize 
The equalize option performs a duplicate function to the EQUAL option in the Contrast 
Adjustment Window.  This is a useful function for detecting faint bands on a sample. 

3.3.2 Arithmetic 
The Arithmetic function is used to add, subtract, average and divide several images 
together to generate a compiled image.   
 

 
 

Image Arithmetic dialog box 
 
To average a set of images together open one of the images in the set and then select 
‘Average a Set…’ under the Image pull-down menu.  A prompt will appear allowing 
the user to select all of the images that for the set.  It is possible to browse the directories 
looking on the network drives and removable media if necessary.  Once all of the images 
have been selected, click on the open button to finish the set.  The resulting image is an 
average of all of the images together.  This is a useful function for extending the dynamic 
range on a set of similar images by allowing bright spots and faint spots to be seen on the 
same image.   
 
The other functions are adding, subtracting and dividing images together.  Adding 
together images is frequently used for colorimetric markers run together with 
chemiluminescent samples.  Subtracting images is often used to remove noise from a 
sample by running dark images first and subtracting them out of the final image.   The 
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most common application for quotient is for those technical users who run their own flat 
field corrections.  This can be done using the Flat Field Calibrate selection under the 
Image pull-down menu which will be described in detail later in this section.   
 
All three of these arithmetic functions are performed by opening the main image that will 
be adjusted.  Next select the appropriate arithmetic function under the image pull-down 
menu.  Then select the image that is to be added, subtracted or divided from the original 
image and select open.  The dialog box will disappear and the resultant image will 
appear. 
 
Note: Images that have been arithmetically altered are ideal for publications and 
documentation, however, they are strongly not recommended for analysis as the 
pixel values have been adjusted.   

3.3.3 Conversion 
Since ImageQuant Capture can generate 16-bit files, the conversion option is useful when 
an image is to be imported into a program that only accepts 8-bit images.   Choosing this 
option will convert a 16-bit image into an 8-bit image. 
 

 
 

Image Conversion dialog box 
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3.3.4 Flat Field Calibrate 
Flat Field Calibrate is a function that is used to ‘flatten’ the image so that the pixel data 
is even across the entire image area.  This is a function that is useful for large gels and 
other applications that use the entire field of view for an image.   
 
Creating flats can be art in itself; there are many documents on the internet that can help 
users interested in this arena to create the ideal flat for the application.  However, some 
useful flats that have been created in the past involve very simple tools like a piece of 8.5 
x 11 regular low quality copy paper (higher quality paper contains watermarks that will 
show up in the final image).  It is essential that both the flat and the gel images be 
identical, including the aperture, zoom (if applicable) and focus settings on the lens.   
 
Step-by-Step Flat Field Calibration: 

1. Place the gel or other application in the cabinet or dark room. 
2. Adjust the aperture, zoom (if applicable) and focus on the lens. 
3. Use auto-expose set to the normal selection and acquire an image of the gel.  

(Alternatively, it is possible to select show saturation and then use the Preview 
option and adjust the exposure time manually to just under saturation.) 

4. Save the image of the gel. 
5. Next, remove the gel from the UV transilluminator or white light tray and 

clean and/or dry off the surface if necessary using glass cleaner. 
6. Place the white piece of paper onto the appropriate surface. (For example, if 

the UV transilluminator was used, place the paper onto the UV 
transilluminator; if the white light tray was used, place the piece of paper onto 
the white light tray.) 

7. Turn on the appropriate light source used (white light, UV transilluminator, 
epi lights, etc.). 

8. Without changing anything on the lens acquire another image of the ‘Flat’ 
image following step #3 again.  

9. Save the Flat image. 
10. Open the original gel or other application image. 
11. Select Flat Field Calibrate from the Image pull-down menu. 
12. Browse the directories for the ‘Flat’ image created. 
13. Click on open.  Make sure to save the flat field calibrated image for future 

use. 
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3.3.5 Image Resize 
The image resize function can be used to resize an image to a specific dimension for use 
in graphical presentations.  You have the option to ‘Preserve aspect ratio’ to avoid image 
dimensional distortion, or you can deactivate this function and configure the image 
resolution to the desired Width and Height dimensions.   
 

 
 

Image Resize dialog box 
 
Note:  It is recommended that you DO NOT perform quantitative analysis on 
resized images. 

3.3.6 Image Info 
The Image Info function provides a dialog box with all detailed image properties. An 
example is shown below.  Click on the OK button to close this dialog box. 
 

 
 

Image Info dialog box 
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3.4 The Setup Menu 
This menu customizes the system settings by allowing users to save default parameter 
preferences and customize the software settings.   
 

 

 

 

 

 

 
Setup pull-down menu 

 

3.4.1 Default Parameters 
Default parameter files eliminate the need to readjust the system settings each time the 
program is used, and can be especially useful if more than one person works with the 
program. 
 
The default file used by ImageQuant Capture when it initially loads is called 
IQcapture.def. The system setting defaults are:  
 
 Exposure Time: 8/milli sec 
 Black Level:  0 

White Level: up to 255, 4095, or 65,535 - depending on the system type 
 Gamma Setting: 0.55 
 REVERSE:  off 
 ARRAY:  96 circles (12 x 8) 
 1D MULTI:  8 lanes 
 
While these parameters can be changed, we do not recommend changing 
IQcapture.def. Instead, we recommend that each user set up an individual default 
file(s) reflecting their preferences. 
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3.4.2 Save Defaults 
Every time a default file is saved, all of the settings for the parameters listed above are 
saved.  These can be loaded later and applied to any image. 

 

 
 

Save Defaults Dialog Box 
 
Once any of the system settings have been changed, a new default file can be created.  To 
save a default file, enter a file name by typing in the text box below the File Name 
prompt.  If it is necessary to change the directory or drive to which the file will be saved, 
select a different directory under the Save In pull-down menu.  ImageQuant Capture will 
automatically add the appropriate 3-character extension. 
 
Click on the SAVE button. The Save As dialog box disappears and a new file is created. 
 
To exit this function without loading a default file, click on the CANCEL button. 

3.4.3 Load Defaults 
This function retrieves system default settings from a saved file. 
 
To open a default file, enter the name of the file by typing its name in the text box below 
the File Name prompt.  If it is necessary to change the directory or drive to which the 
file will be saved, select a different directory under the Save In pull-down menu.   
 
Once the file has been selected, click on the OK button to load the file. The Load 
Defaults dialog box disappears and the image controls are adjusted to reflect the settings 
in the file loaded. 
 
To exit this function without loading a default file, click on the CANCEL button. 
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3.4.4 Security 
When the system is shared by a number of people or laboratories, a method of keeping 
track of its use may be helpful.  The Security feature allows various levels of security 
and user log functions. 
 
We suggest one user be designated as the supervisor of the system. This individual 
should refer to Appendix B, which describes the security features in detail.   
 
Note: It is strongly recommend that you remove Appendix B from the manual to 
avoid unauthorized users changing the password and the security settings. 
 
 

3.4.5 Print Info 
When printing an image, basic image information is included on the print.  This includes 
the exposure time, the Black level, White level, and Gamma setting, the date and time 
the image file was generated, an image ID number, and the name of the file to which the 
image is stored.   
 

 
 

Setup Print Image Info Dialog Box 
 
To print this information at the top of the print, choose Top from this menu.  To print at 
the bottom of the print, choose Bottom.  
 
Note:  Printing image information at the top or bottom of a print may obscure a 
small portion of the image. To print the image with no information on it, choose Off. 
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3.4.6 Print Mode 
ImageQuant Capture provides custom printing options.   
 

 
 

Setup Print Image Info Dialog Box 
 
Printing can be achieved using three different methods: 
 
Full Image: Prints the original image. Does not print zoomed images or 

images overlaid with data screens. 
Screen Dump: Prints the imaging area.  Well suited for printing images overlaid 

with data screens and/or graphs, zoomed images, etc. 
Image Window: Prints the highlighted window. 
  

3.4.7 Print Date 
Under the “Setup” menu there is a selection labeled “Print Info”.  This allows the user to 
change the format in which the date is printed.  The choices are MM/DD/YYYY and 
DD/MM/YYYY. 

3.4.8 Preferences 
In order to change the preferences of the system, you will need to find the administrator 
of the ImageQuant Capture application to log in.  If you do not have an administrator for 
ImageQuant Capture, see Appendix B in this manual. 
 

 
 

Login Dialog box for Preferences 
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There are four tabs in the Preferences: 
  

1. General – Configure prompts and file saving/opening formats. 
 

 
 

2. Image Acquire – Inverts the image seen by the camera and adjusts the ROI 
values. 
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3. Cabinet Settings – Used for adjusting the port settings and customizing filter 
positions on the cabinet. 

 

 
4. Auto Enhancements – Used to customize the Auto Enhance Levels located 

in the tool box. 

 
To make changes to the preferences, select your change by typing in a new value or 
select/de-select the appropriate box with a check mark and then select apply.  Some 
settings may require that the software be restarted before the change will take effect. 
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3.5 The Overlay Menu 
The Overlay menu provides a means of saving and retrieving annotation overlays.  This 
is especially useful when a standard gel format is run repeatedly.  Lane numbers, 
molecular weight marker sizes, and other pertinent information can be stored as an 
Overlay file and retrieved at a later date. This eliminates the need to re-enter the 
information each time a new image is captured.   
 

 
 

Overlay pull-down menu 
 
An overlay is any set of annotations (text, boxes, arrows, etc.) that have been drawn on 
the image.  They can be saved as a group and opened later.   If repetitive samples are 
being imaged, an overlay eliminates the need to re-enter the same information (such as 
lane numbers, standard sizes, etc.) continually. 

3.5.1 Saving an Overlay 
Once annotations have been made, select Save Overlay from the Overlay menu. 
 

 
 

Save Overlay dialog box 
 
Enter a new file name in the text box below the File Name prompt.  ImageQuant Capture 
will automatically give the appropriate 3-character extension. 
  
The current directory is the one in which the new overlay file will be saved.  If 
necessary, change the directory or drive as described in Section 3.1. 



ImageQuant 400 User Manual 
 

 
 

 68 

Once a name has been entered and the appropriate directory has been accessed, click the 
SAVE button to save the overlay file. 

3.5.2 Loading an Overlay 
The Load Overlay function allows Overlay files to be retrieved and applied to the image 
currently displayed.  
 
Opening an Overlay after an image has been captured places the annotations on top of 
the image.  They can be stored as part of the image by saving the file as a modified file.   

 
Select the name of the file to be loaded. (If necessary, change the directory or drive.)  The 
file name is then highlighted in the list and appears in the text box below the Filename 
prompt. 
 
Once the file has been selected, click on the OK button to load the file.  (Alternatively, 
double-click on the file name.)  The dialog box disappears and the annotations in the 
selected file appear on the image. 
 
To dismiss the dialog box without loading annotations, click on the CANCEL button. 

Overlay Libraries 
ImageQuant Capture contains a library of overlays that can be accessed through the Load 
Overlay function described above.  This library of overlays is stored in the Image folder 
located in the ImageQuant Capture directory: 
 

08WHITE.OVR / 08BLACK.OVR 8 lane labels in white/black 
10WHITE.OVR / 10BLACK.OVR 10 lane labels in white/black 
12WHITE.OVR / 12BLACK.OVR 12 lane labels in white/black 
15WHITE.OVR / 15BLACK.OVR 15 lane labels in white/black 
24WHITE.OVR / 24BLACK.OVR 24 lane labels in white/black 
HINDIII.OVR “λHindIII” label 

 
The objects in these overlays can be repositioned, resized, re-colored, copied or deleted 
as needed. 
 
Note: Overlays are specific to the resolution of the image that they were created on. 
Therefore, if an overlay was created on an image with a different resolution than the 
image that the overlay is being loaded onto, the overlay may not match the original 
image. 
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3.6 The Utilities Menu 
A number of functions are now handled by Windows programs.  To access many of these 
programs while in ImageQuant Capture, open the Utilities menu and select the program 
of choice. 
 
 

 
 
 

Utilities pull-down menu 
 

3.6.1 Explorer 
 
This option can be used as a shortcut to Windows Explorer, which allows access to files 
and other information saved on the local machine or the network.   
 
 

3.6.2 Notepad  
 
The Notepad is a blank screen that allows the user to make notes about the experiment 
and save them as an ASCII file. The Notepad is useful for saving any imaging comments 
or experimental conditions with the saved image for future reference. 
 

 
 

Notepad Display Window 
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3.7 The View Menu 
The View function provides the ability to control the display of the on-screen control 
tools as well as provide image enhancement abilities. 

 

 
 

View pull-down menu 
 
Four main tools exist within ImageQuant Capture:  Contrast Adjustment, Tool Bar, Status 
Bar, and Tool Box: 

 
Contrast Adjustment Window 

 

Tool Bar Window 
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These tools are automatically displayed when ImageQuant Capture is launched for 
additional ease of use and to generate a common ‘look and feel’.  However, if you would 
like to hide any of these tools they can be turned off in the View menu by just 
deactivating the check mark next to the item that you would like to remove from the 
screen.  Also, since these items are ‘floating’ tools, you can click on Default Tools 
Position to move all tools to the default locations for more intuitive operation.   Lastly, 
except for the status bar, it is possible to select and move any of the other tools to a 
custom location.   
 

3.7.1 Zoom Functions 
Additional options provide the ability to Zoom In and Zoom Out on the image, Zoom to 
1X and to Fit to Screen.   
 
Note:  Zoom In and Zoom Out are duplicate functions for the Zoom In and Zoom 
Out icons in the Tool Bar and the Zoom options in the Tool Box. 
 

3.7.2 Show Annotations 
There is also an option to display/not display any annotations associated with the current 
image.  To display the annotations, place a check mark next to the ‘Show Annotations’ 
option in the View menu.  Otherwise, remove the check mark to remove the annotations 
from the image viewing area (the annotations are not deleted by selecting this option). 
 
 

 
 

Status Bar 
 

Tool Box 
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3.8 The Help Menu 
 
 

 
 
 

Help pull-down menu 

3.8.1 On-Line Note 
On-line help is available in the ON-LINE NOTE section of the help menu.  Common 
tips are included for the image enhancement tools detailed in Chapter 4. 

3.8.2 About 
To display system information, select the About option in the Help menu.  This button 
accesses a pop-up box.  This box shows the system serial number and software version 
number.  Use this information when contacting technical support, upgrading software, 
etc. 
 

 
 

ImageQuant Capture About Help Dialog Box 
 
To close the box, click on the OK button. 
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Chapter 4: The Tool Box 
Image enhancement tools are contained within the Tool Box as indicated.   This tool set 
allows the user to zoom the image, rotate-flip the image, show the image histogram, 
perform automatic image enhancement, annotate on the image, display false colors, apply 
software filters, and activate the FrameGrabber function. 

4.1 The Zoom Tool  
 

 
 

The Zoom Tools 
 
The Zoom tool is found in the Tool Box. This function magnifies an image, making 
details easier to see, and allows movement around the magnified image. An image can be 
displayed ¼x, ½s, 1x, 2x, 4x, or 8x larger than the original display by clicking on the 
appropriate buttons. To return to the original magnification, click on the 1X button. When 
an image is magnified, only part of it can be displayed on the screen at any one time. To 
see different parts of the magnified image, use the Pan Control box within the 
thumbnail. The outer box shows a thumbnail of the entire image while the small, inner 
box represents the portion currently displayed on the screen.   
 
To view different regions of a magnified image, move the cursor into the inner box. Click 
and hold down the left mouse button.  The cursor changes to a hand; use it to drag the 
box within the thumbnail until the desired region of the image appears on the screen. 
Alternatively, use the scroll bars in the main image window to move the image up/down, 
and left/right. On-screen Zoom tools are also available from the tool bar. These buttons 
duplicate the Zoom tool in Tool Box, and also allows for Img Drag to easily pan 
zoomed images.  

 
 

  
Zoom icons in Tool Bar Img Drag Icon in Tool Bar 
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4.2 The Rotate / Flip Tool 
The Rotate / Flip tools are found in the Tool Box.  This function rotates the image in a 
clockwise or counterclockwise direction by 1 degree increments up to a maximum of 90 
degrees in either direction.  This is a useful tool if the image is not aligned properly 
during the capturing process.   
 

 
 

The Rotate / Flip Tool 
 
To rotate an image, click and hold down on the center sliding bar with the left mouse 
button and move it left or right until the desired angle of rotation appears in the rotate 
box.  Release the left mouse button and image will rotate to the desired angle.  To undo a 
rotation, just click on the Undo button.  Also, a Flip option allows for the image to be 
rotated 180 degrees in a vertical or horizontal fashion. 
 
The Reset button on the main software interface will also remove any rotations or image 
flips and return to the display to the original image. 
 

   
Rotated 12 degrees clockwise Image rotated -12 degrees 

(Counterclockwise) 
Image rotated 12 degrees 

and flipped vertically 
   

 

   
Rotate / Flip box at 12 degrees Rotate / Flip box at –12 degrees Rotate / Flip box at –12 degrees 

and vertical flip button pressed 
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4.3 Histogram 
The histogram is a graphical display of the proportion of pixels assigned to each of the 
4,095 gray levels.  This tool is found in the Tool Box. 
 

 
 

Histogram display in the Tool Box 

 
The image is made up of picture elements (pixels) having brightness levels ranging from 
black to white. A very bright image will have most of its pixels registering high gray 
levels and conversely, a very dark image will have most pixels with low gray levels 
(approaching zero). 
 
The histogram is displayed in the lower left corner of the screen, below the image 
window. The horizontal axis represents the gray scale range: black at the left end and 
white at the right end, with levels of gray in between. The number of pixels registering a 
particular gray level determines the height of each bar along the axis. 
 
A Coomassie blue-stained protein gel visualized with a white light box has a histogram 
reflecting mostly bright pixels:  

 

 
Histogram of a typical Coomassie gel 

 
Most of the pixels are found in the light portion of this histogram. The dark bands 
represent a small number of pixels and include a variety of gray values, and therefore do 
not show up as a single peak. 
 
The histogram function is particularly useful to verify that an image spans the maximum 
range of gray levels.  When an image is to be used for analysis, it is especially important 
that the gray level range be as large as possible.  If an image does not include most of the 
gray levels, we recommend repeating the image capturing process. 
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4.4 Automatic Enhancement 
The Enhance tool is found in Tool Box.  This function is ideal for new or inexperienced 
users of the system since it offers 9 levels of automatic image enhancement of the black, 
white, and gamma levels simultaneously.  For an inexperienced user, it can be difficult 
to adjust each black, white, and gamma buttons to their respective optimal positions.  By 
clicking on one of the nine Auto Enhance Level buttons, the image is optimized 
according to a unique level.  Button 1 will make the image ‘darker’. Each increasing 
button click will ‘lighten’ up the image until button 9 is pressed which will make the 
image the ‘lightest’ possible. 
 

 
The Enhance Tools 

 
 
To undo any Auto Enhance Levels, just press on the Reset button on the main 
interface. 
 

 
 

Original Image 
 

Auto Enhance Level 2 Image 
 

Auto Enhance Level 9 Image 
   
 

  
 

Original Auto Enhance Toolbox 
 

Auto Enhance Toolbox with level 2 
 

Auto Enhance Toolbox with level 9 
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4.5 Annotations 
The annotation tools, found in the Tool Box, include a number of different options for 
adding text (including Greek symbols), drawing arrows and otherwise marking an image.  
Note that these tools are for annotation only.   
 

 
Annotation Tools 

4.5.1 Object Attributes 
Use the COLOR, PEN WIDTH, PEN STYLE, LINE ENDS, TEXT STYLE and/or 
TEXT ORIENT menus to specify object attributes.  Attributes can be assigned to the 
cursor before drawing or typing.  Alternatively, they can be assigned to an object while it 
is in “edit” mode (see the following pages for more details). 

4.5.2 Annotation Colors 
Annotations can be displayed in a variety of colors.  The color options are displayed by 
clicking the COLOR checkbox.  To select a color, simply click the cursor on the button 
labeled with the desired color.  The color button appears depressed, indicating that it is 
selected.  Any annotations subsequently entered will appear in that color.  It should be 
noted, however, that annotations are printed in gray scale on the video printer.  Further, 
when an image is saved as a modified image, the annotations are saved in gray-scale, not 
color. 

 
Pen Color Selection Tools 
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4.5.3 Line Thickness 
The PEN WIDTH menu specifies the thickness of lines when using the freehand, lines, 
box and circle drawing tools. Click on the appropriate checkbox for the desired width.  
All annotations subsequently entered will appear at that width. 
 

 
Pen Width Selection Tools 

4.5.4 Line Types 
 
The PEN STYLE menu specifies the style of lines when using the freehand, lines, box 
and circle drawing tools. Click on the appropriate checkbox for the desired style.  All 
annotations subsequently entered will appear in that style.  Note:  these pen styles only 
work with a thin line (see Line Thickness above). 
 

 
Pen Style Selection Tools 

4.5.5 Arrows and Straight Lines 
 
The LINE ENDS menu specifies the style of the ends of straight lines (no arrow, single 
arrow or double arrow). Click on the appropriate checkbox for the desired style.  Note:  
these line ends work with any line thickness. 

 
Line Ends Selection Tools 
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4.5.6 Text Background and Font 
 
The TEXT STYLE menu specifies the style of text. Click on the appropriate checkbox to 
show text with or without a background.  An opaque background is useful if annotations 
will be made on an image that has wide variations in gray scale.  By using an opaque 
background, text will not be “lost” in the background of the image. 
 

 
Text Style Selection Tools 

 
 
This is also the window in which specific font is chosen.  When the Set Font button is 
depressed, a selection box appears, from which text style can be chosen. 
 

 
Font Selection Window 

Note: 
To choose Greek symbols (such as α, β, λ, π, and θ) choose the Symbol font: 
 
 a  b  c  d  e  f  g  h  i  j  k  l  m  n  o  p  q  r  s  t  u  v  w  x  y  z 
 
 α  β  χ  δ  ε  φ  γ  η  ι  ϕ  κ  λ  μ  ν  ο  π  θ  ρ  σ  τ  υ  ϖ  ω  ξ  ψ  ζ 
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4.5.7 Text Angles 
In the TEXT ORIENT window, select whether text should be oriented vertically, 
horizontally, or at an angle (in 15° increments). 
 

 
Text Orientation Selection Tools 

 
Note:  only rotate fonts that are True Type (indicated by TT in front of the name); other 
fonts (such as Courier and Fixedsys) do not re-scale properly, giving unpredictable 
results. 

4.5.8 The Drawing Tools 
Once the object attributes have been defined, click the cursor on any of the drawing tool 
buttons to assign the function associated with that button to the mouse.  The cursor will 
change from an arrow to a cross, indicating that ImageQuant Capture is in “drawing” 
mode. 
 
After selecting a drawing tool, move the cursor to the correct position on the image to 
begin drawing.  Press and hold the left mouse button and move the mouse to the end 
point of the object to be drawn.  Release the left button, and the object should now 
appear. 
 
Boxes will appear at the corners of the new object and the cursor will revert to an arrow, 
indicating that ImageQuant Capture is now in “edit” mode.  At this point, the object can 
be resized or repositioned.  The color, pen thickness, line type, etc. can also be changed, 
simply by clicking on the desired choice (as described in Object Attributes above). 
 
To draw another object, click the right mouse button to return to “draw” mode, or 
click on one of the drawing tool buttons. 
 

 The button labeled with an "A" adds text to the image.  Place the cursor at the 
location on the image where the left edge of the text should appear.  Click the left mouse 
button and begin typing.  To place another piece of text, click where it should be placed.  
Once all text is entered, click on the right mouse button. To edit text, double-click on it.  
An edit window will appear, in which changes can be made. To change fonts, see Text 
Background and Font above. 
 

 The button labeled with a pencil icon allows the user to draw lines freehand. After 
clicking on the pencil, move the cursor to the correct position on the image to begin 
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drawing.  Press and hold the left mouse button.  Using the mouse, move the cursor as if it 
were a pencil.  When finished drawing, release the mouse button. 
 

  The button labeled with a diagonal arrow draws arrows and straight lines. After 
clicking on the button, move the cursor to the position on the image where the line should 
begin.  Press and hold the left mouse button.  Using the mouse, move the cursor to the 
other end point of the line then release the mouse button.  The arrow can be adjusted by 
clicking on one of the boxes at the end (the other will serve as an anchor point) or by 
clicking in the middle to drag the entire arrow. 
 

 The button labeled with a rectangle draws a rectangle or square of any size on the 
image.  After clicking on the button, move the cursor to the position that should 
correspond to one of the corners of the rectangle.  Press and hold the left mouse button.  
Using the mouse, move the cursor to enlarge the rectangle.  Release the left mouse button 
when it reaches the desired size. 
 

 The button labeled with an oval draws a circle of any size. After clicking on the 
button, move the cursor to the position on the image where the circle should be started.  
Press and hold the left mouse button.  Using the mouse, move the cursor to enlarge the 
circle.  Release the left mouse button when the circle reaches the desired size. 
 
Hint:  to draw a perfect circle around a portion of an image, first visualize a square 
surrounding the area of interest.  Position the mouse in the upper left hand corner of the 
square.  Click and drag the mouse down across the area of interest at a 45° angle until the 
circle encloses the area of interest. 
 

 
 
 
 
 

Sample Annotations 
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Annotated image showing: freehand drawings, lines with various  
characteristics, circles, squares, text with various characteristics 

 

4.5.9 The Editing Tools 
When the cursor is in “edit” mode, it can be clicked on an object to select it.  (Note:  the 
cursor can be toggled between “edit” and “drawing” modes by clicking the right mouse 
button.)   
 
When an object is selected, small square boxes appear at the corners.  Selected objects 
can be resized, copied, deleted or moved: 
• To resize an object, click on one of the gray boxes at the corners of its perimeter and 

drag the box until the object reaches the desired size.   
• To copy an object, use the Copy tool. 
• To delete an object, use the Cut tool or the Eraser. 
• To move an object, click within its boundary and drag it into the desired location.   
 
To select more than one object, outline them with the mouse; any objects that fall 
completely within the outline drawn will be selected.  (Note:  The entire object must be 
enclosed by the cursor’s movement in order to be selected.) 
 

 
A Selected Object 
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 Once an object or group of objects has been selected, clicking on the Cut tool 
deletes it from the image. 
 

 The Copy tool makes an exact copy of the selected object.  The new object 
becomes the selected object, and can be repositioned by placing the cursor within the 
object’s boundary and moving it to the desired location. 
 
  

 The Horizontal Alignment tool aligns annotations in a straight horizontal line.  
This is especially useful for labeling lanes, etc.  To use this tool, draw text on the image, 
select it, click the Horizontal Alignment tool, then deselect the text.  The text will now 
be aligned in a straight line across the image. 
 

 
Text Prior to Horizontal Alignment 

 

 
Text after Horizontal Alignment 

 

 The Vertical Alignment tool aligns annotations in a straight vertical line.  This is 
especially useful for labeling markers, etc.  To use this tool, draw text on the image, 
select it, click the Vertical Alignment tool, then deselect the text.  The text will now be 
aligned in a straight line down the image. 
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4.6 False Color 
These tools consist of eleven pre-defined color palettes that can be applied to an image.  
To select a palette, simply click on one of the four buttons labeled GRAY PALETTE, 
SATURATION, NEXT or PREVIOUS. 
 

 
False Color Selection Box 

 
When a palette is selected, its range of colors is displayed to the left of the palette buttons 
and automatically applied to the image. To apply a different palette to the image, click 
the NEXT or PREVIOUS buttons.  
 
Note:  changes in Black level, White level and Gamma setting can alter the effect of 
each of the palettes, and can enhance the results produced. 

4.6.1 Gray Scale (Palette 0) 
This is the default or standard gray scale, consisting of different gray levels, ranging from 
black to white. 

4.6.2 Saturation (Palette 1) 
This is a modified gray scale palette in which black is replaced with green, and white is 
replaced with red.  Over- and under-exposed areas of the image are thus shown as green 
or red, while areas within the linear range of the CCD chip are shown in gray scale.  The 
Saturation Palette is especially useful during quantitation, as areas outside the linear 
range of the instrument do not give accurate quantitative information.  This palette allows 
the user to avoid those areas during quantitative analysis. 
 
This palette can also be accessed by clicking the Show Saturation checkbox in the 
Camera Setup and Preview function (accessible by clicking on the Camera icon in the 
Tool Bar) 
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4.6.3 Palettes 2 through 11 
These are color substitution palettes in which the gray levels are translated into different 
color ranges.  These palettes can be useful to help distinguish features and highlight 
details on an image.   
 
Palette 2 maps the gray scale levels to a red/green/blue palette.  Values of 0 are mapped 
to red; saturated to blue, and values in between to green. 
 
Palette 3 maps the gray scale levels to a red/green/blue palette.  Values of 0 are mapped 
to blue; saturated to green, and values in between to red. 
 
Palette 4 maps the gray scale levels to a red/green/blue palette.  Values of 0 are mapped 
to green; saturated to red, and values in between to blue. 
 
Palette 5 maps the gray scale levels to a cyan/magenta/yellow palette.  Values of 0 are 
mapped to cyan; saturated to yellow, and values in between to magenta. 
 
Palette 6 maps the gray scale levels to a cyan/magenta/yellow palette.  Values of 0 are 
mapped to yellow; saturated to magenta, and values in between to cyan. 
 
Palette 7 maps the gray scale levels to a cyan/magenta/yellow palette.  Values of 0 are 
mapped to magenta; saturated to cyan, and values in between to yellow. 
 
Palette 8 maps the gray scale levels to a red palette.  Values of 0 are mapped to dark red; 
saturated to white, and values in between to shades of red. 
 
Palette 9 maps the gray scale levels to a blue palette.  Values of 0 are mapped to dark 
blue; saturated to white, and values in between to shades of blue.  This palette may be 
useful when printing an image of a Coomassie-stained protein gel onto a color printer. 
 
Palette 10 maps the gray scale levels to a green palette.  Values of 0 are mapped to dark 
green; saturated to white, and values in between to shades of green.  This palette may be 
useful when printing an image of a SYBR® Green I-stained protein gel onto a color 
printer. 
 
Palette 11 maps the gray scale levels to an orange palette.  Values of 0 are mapped to 
dark orange; saturated to white, and values in between to shades of orange.  This palette 
may be useful when printing an image of an EtBr-stained gel onto a color printer. 
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4.7 Image Filters 
ImageQuant Capture includes a variety of enhancement filters that can improve the 
appearance of an image. Some filters sharpen details and others smooth and reduce 
random noise.  Still others help visualize edges and separate closely spaced bands or 
objects.  Depending upon the unique characteristics of an image, the results of each 
filtering operation vary. Assess the characteristics of the image and then select the filter 
designed to minimize its imperfections. 

 
Filter Tools with 3-D (contour) selected 

 
When an image is filtered, the original image information is replaced with the results of 
the filtering operation. As a result, the original image information is altered. To avoid 
losing the original image, save it as an original TIFF file before applying a filter. 
 
When the FILTERS tab is selected in the Tool Box, a pop-up dialog appears.  If the 
desired filter is not shown, choose MORE to display more filters.  One or many filters 
can be applied to a single image.   

 

 
 

The Filter Tools with Sharpen highlighted 
 

 
 

The Filter Tools with More selected 
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4.7.1 General Information on How Filters Work 
To enhance an image, filters change the value assigned to each pixel.  The new value 
assigned to a pixel is determined based on the values of the other pixels in its local 
vicinity (or “neighborhood”).  The neighborhood is a two-dimensional matrix of pixel 
values, where each dimension has an odd number of elements.  The "pixel of interest" is 
the one at the center of the neighborhood. This is the pixel whose old value is being 
replaced with a new one as the result of the filtering algorithm. 
 
The pixels in a neighborhood provide information about the brightness trend.  This 
information is important to the filtering process.  The brightness trend is also referred to 
as the "spatial frequency."  Images with high spatial frequency content contain large, 
closely spaced changes in pixel values.  For example, on a black and white checkerboard, 
the smaller the squares, the higher the frequency content. 
 
Images with low spatial frequency content (for example, images of clouds) contain large 
areas of slowly changing pixel values. 
 
Most of the filter options available (with the exception of the Noise filters) use a 
weighted summation process to determine the value assigned to the pixel of interest. Each 
pixel in a 3x3 neighborhood is multiplied by a "convolution kernel" having the same 
dimensions.  The resulting sum is assigned to the pixel of interest. 
 

       (K1xP1)+ 
       (K2xP2)+ 
       (K3xP3)+ 
       (K4xP4)+ 
 P1  P2  P3  K1  K2  K3  (K5xP5)+ 
 P4  P5  P6  X K4  K5  K6  (K6xP6)+ 
 P7  P8  P9  K7  K8  K9  (K7xP7)+ 
    (K8xP8)+ 

 3x3 pixel neighborhoodconvolution kernel (K9xP9) 
(P5 is being calculated) New Value for P5 

 
 
Each element of the convolution kernel is a weighting factor, also called a "convolution 
coefficient." The size and arrangement of these weighting factors determine the type of 
transformation the image will undergo. Changing a weighting factor influences the 
overall sum and, therefore, affects the value given to the pixel of interest. 
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4.7.2 Sharpening Filters 
These filters can increase image sharpness and provide edge enhancement.  However 
image noise may be enhanced as well. These filters accentuate the high-frequency details 
of an image while leaving the low-frequency content intact. High frequency portions of 
the image get brighter while low frequency portions become black.   
 
Sharpen level 9 (high) has the largest effect on the image. Sharpen level 5 has an 
intermediate effect. Sharpen 1 (low) has the most subtle effect on the image.  9 different 
sharpening levels are available for optimization of the image. 

4.7.3 Noise Filters 
This filtering process uses the values of the pixels contained in the area surrounding a 
pixel to determine the new value given to the pixel of interest.  The noise filter sorts the 
pixels in the neighborhood into ascending order and picks the middle or median pixel 
value as the new value for the pixel of interest.  3 levels of noise reduction are available. 

4.7.4 Despeckle Filters 
The despeckle filter is a type of smoothing filter based on data rejection. Pixels in the 
neighborhood (usually the adjacent pixels) are used as a data set upon which the average 
and standard deviation of the set are calculated. If the pixel of interest (the center of the 
neighborhood) is different from the neighborhood average (either greater or lesser) by a 
threshold (a multiple of the standard deviation) it is replaced by the average value.  
 
The effect of the filter is to "smooth" pixels that are much different from their neighbors. 
Artifacts such as hot pixels, cosmic rays etc. are commonly rejected by this type of filter. 
The filter strength is controlled by the threshold factor. For large factors very little data is 
rejected as only very large deviations are required for rejection, where as, low thresholds 
result in more smoothing.  (For example, setting #1 results in outliers of 1 standard 
deviation greater or lesser than the neighborhood average to be corrected for, setting #2 
results in outliers of 2.5 standard deviations to be corrected for and setting #3 results in 
outliers of 5 standard deviations to be corrected for.) 
 
These filters are particularly effective in eliminating random noise contained in an image 
and produce less blurring than the Noise filter described above. 

4.7.5 3-D (Contour) Filters 
These filters are particularly useful for visualizing faint bands. They produce a "3-D" 
effect, defining edges and making details easier to see. 
 
3-D level 9 (high) has the largest effect on the image. 3-D level 5 has an intermediate 
effect 3-D level 1 (low) has the least effect on the image.  9 different 3-D levels are 
available for optimization of the image. 
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In addition, 3-D allows the user to control the ‘direction’ of the 3-D shadowing effect.  
Once the level is refined, just click on a direction arrow to visualize the shadowing 
adjustment.  The default shadow direction is in the lower right hand corner direction and 
9 different directions are available. 
 
 

   
Original Image 3-D Image Level 5 & lower right 

shadow 
3-D Image Level 5 & upper 

middle shadow 
    

 
Original filter settings Lower right shadow Upper middle shadow 

4.7.6 Smoothing Filters 
These filters are very useful for reducing the visual noise present in an image. When a 
smoothing filter is applied to an image, rapid changes in intensity are averaged out with 
the remaining pixels in the neighborhood, thereby decreasing the high frequency content.  
The visual result is a slight smoothing of the image because sharp pixel transitions are 
averaged with their surroundings.   
 
Smooth High has the largest effect on the image. Smooth Med has an intermediate 
effect. Smooth Low has the most subtle effect on the image. 

4.7.7 Edge Filters 
These filters use Laplacian enhancement to highlight edges, regardless of direction.  All 
edge-enhancement operations attenuate the low frequencies of the image.  Regions of 
constant intensity or linearly increasing intensity become black as a result of these 
transformations, and regions of rapidly changing intensity values are highlighted.   
  
Note:  The White level may need to be adjusted after using the Edge filters in order 
to see the result of this filtering process. 

4.7.8 Horizontal Edge Filter 
This filter brightens horizontal edges.  This can be useful in pinpointing bands on a gel.  
The horizontal edge filter (Horz. Edge) enhances image edges by shifting an image 
vertically by one pixel and then subtracting the shifted image from the original.  In an 
area of constant pixel intensity, the subtraction yields black pixel values.  At an edge, 
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which is an area with large changes in intensity, the subtraction yields light-colored pixel 
values.  The larger the difference in intensities, the lighter the resultant pixels.   
 
Note:  After applying the horizontal edge filter the entire image may appear 
black, and might require reducing the White level in order to better visualize the 
results. 

4.7.9 Vertical Edge Filter 
This filter (Vert. Edge) brightens vertical edges using the approach described for the 
horizontal edge filter (see above), except that the image is shifted horizontally before the 
shifted image is subtracted from the original.  In this case, the vertical edges produce 
light-colored pixel values.  As in the horizontal edge filter, it may be necessary to adjust 
the White level in order to better visualize the results of this filtering process. 

4.7.10 Custom Filter 
This function also allows the user to customize filters.  Using the weighting factors of the 
other filters as a frame of reference, it’s possible to experiment with new weighting factor 
values.  
 

4.7.11 The UNDO Button 
The upper right button is labeled UNDO.  This reverses the last filtering process applied 
to an image.  To revert the image to its original state after multiple filters have been 
applied, press the RESET button on the main interface. 
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4.7.12 Examples of Filter Results 

   
Original Image Noise Level 3 (High) Sharpen Level 9 (High) 

   
SmoothHigh EdgeHigh 3-D (Contour) Level 5 

  

 

Horizontal Edge Vertical Edge  
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4.8 FrameGrabber Mode 
If kinetic, multiplex, color, or chemiluminescence experiments are desired where you 
wish to have the system automatically capture several images at preset exposure times, 
preset time delay between images, preset lighting sources, and preset filter choices, the 
FrameGrabber tab can be clicked in the Tool Box. (FrameGrabber setup is also 
accessible in camera setup acquisition screen.  To access this screen select the acquire 
button on the tool bar and then select ‘FrameGrabber’ on the acquisition screen: 
 
                                   

    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FrameGrabber button in 
the camera setup 
acquisition screen 

FrameGrabber Setup in the Tool Box 
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Once FrameGrabber is selected, a display box will appear for independent control of all 
lighting, filters, and exposure delay for each image frame. 
 
The TOTAL FRAMES setup provides 
you with the ability to determine how 
many individual frames (images) you 
want for the sequence.  There is a 
maximum of 50 frames (images) and a 
minimum of 1 frame that can be 
captured with each sequence.   
 
The FRAME selection is used for 
setting up the conditions for each frame 
(image).  For example, if three (3) 
images are to be captured, you would 
choose FRAME 1 and setup all of the 
desired lighting and filter requirements.  
You can then click on FRAME 2 and 
repeat the above.  Or, you can click on 
COPY TO NEXT to help speed up the 
setup process.  COPY TO NEXT copies 
all settings from the previous frame to 
the current frame.   
 
 
Usually, for chemiluminescence imaging, all lighting is off and the filter wheel is 
positioned for the chemiluminescence position for all frames.  Thus, the only variable 
that is changing from one frame to the next is the exposure time.  In this situation, COPY 
TO NEXT is a useful tool to save time in the setup process. 
 
If you are performing kinetic experiments where you want to have a predetermined delay 
between captured images, then you can use EXP DELAY to configure this function.  The 
default EXP DELAY is set for the shortest possible delay (19 milliseconds), but can be 
configured up to 50 minutes between each image.  Also, if your exposure delay and/or 
exposure time and/or lighting options/filter position is consistent for the entire sequence, 
then once you set up the first frame, you can select the COPY TO END selection to 
automatically choose the first frame settings for the entire sequence of frames (images). 
 
Once the sequence is set up to the desired configuration, click on the GO button.  The 
software will then begin the process of image acquisition for each frame of the image. 
When the process is complete, the Camera Setup and Preview window will disappear and 
the TOOL BOX will automatically switch to the FrameGrabber tab.  This will allow you 
to play back the sequence, save or load the sequence, or record a new sequence. 
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Once all images have been captured, the FrameGrabber tab will be displayed in the Tool 
Box.  The remaining buttons will perform the following tasks: 
 
REC Opens the Camera Setup and Preview window to record a 

sequence. 
PLAY   Display a continuous loop of all of the captured images. 
STOP   Stop the sequence at the current frame display 
PAUSE  Pause the playback of the sequence at a user defined image 
REW (rewind) Rewind the sequence to the first image 
REV (reverse)  Play the sequence in a continuous loop in reverse 
FWD (forward) Moves forward in the sequence to the last image. 
DEL (delete) Delete the sequence on the display.  THIS FUNCTION WILL 

NOT DELETE A SEQUENCE SAVED TO THE HARD DRIVE. 
LOAD Load a previously saved sequence.  THIS FUNCTION WILL NOT 

LOAD INDIVIDUAL IMAGES PREVIOUSLY CAPTURED IN 
NORMAL CAPTURE MODE. 

SAVE Save a sequence of images.   

4.8.1 Saving an Individual Image from a Sequence 
After you load, play, and stop a sequence at the desired image, it is possible to save the 
individual image seen on the screen.  Use the SAVE AS button located on the tool bar to 
save the image in the desired location and file format on the local or network drives.   
 

Note: This will save the current image only.  To save the entire sequence, select 
the ‘save’ icon on the FrameGrabber tab in the Tool Box. 

 

4.8.2 Loading/Saving an Entire Sequence 
You can load or save an entire sequence by using the load and save icons in 
the FrameGrabber tab in the Tool Box.  When a sequence is loaded the loaded 
frames will be seen as blue in the frame reel.  When a sequence is saved a 

dialog box will appear prompting you to select the location and name for the sequence 
that you would like to save the images as. 
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4.9 FrameGrabber:  Save/Load FrameGrabber 
Setup Routines 

 
Two buttons “Save Setup” and “Load Setup” allow you to save and load all 
FrameGrabber setup parameters.  Files are saved as *.mvf files. 
 

 

4.9.1 Frame Stacking 
At the top of the Camera Setup and Preview window is an option for stacking frames. If 
this selection was chosen during acquisition of the image Stack Frames will use all 
previous exposure information to sequentially add images to one another.  Normal 
Sequence will not perform this addition.  Please note that stacking frames will increase 
the noise level in acquired images.    
 
 Sample case: 
  Capture 5 frames at 1-5 sec exposure for total time elapsed 15 sec 
  Display after summation of following frames: 

 Frame 1 (1 sec) 
      Frame 2 (1 + 2 sec) 
     Frame 3 (1 + 2 + 3 sec) 
     Frame 4 (1 + 2 + 3 + 4 sec) 

      Frame 5 (1 + 2 + 3 + 4 + 5 sec) 

Load Setup and 
Save Setup buttons 
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4.9.2 Capturing a Color Image Using the FrameGrabber Function 
A color image can be generated by acquiring three images each taken with a red, green 
and blue emission filter.  Once saved, these images are then combined in the Overlay 
pull-down menu.  Open the image captured with each of the three filters as instructed and 
a RGB (red, green, blue) true color image will be generated. 
 
For color imaging, you will need to use the following optional filters: 

 Red Filter SYPRO® Red Filter 

 Blue Filter Hoechst Blue Filter 

 Green Filter SYBR® Green Filter 
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Chapter 5: Analyzing Images 
Once you have acquired an image using ImageQuant Capture, you can transfer it to one 
of ImageQuant TL’s analysis modules using the toolbar options. The ImageQuant 
Capture toolbar contains 4 buttons: 1D, Array, Colony and Toolbox: 
 
 

1D 
This is a gel or TLC plate analysis module. 
 
Array 
The Array module to analyze microplate images, gridded 
arrays, and dot and slot blot images. 
 
Colony 
The Colony Counter module can be used to analyze 
images by detecting and measuring image features, 2D 
spots, or colonies. You can display and print measurement 
data from the detected colonies. 
 

 

Toolbox 
The Toolbox module allows you to perform analysis on a 
wide variety of images. The flexible nature of this module 
means that you are not restricted to a single type of 
analysis when it is used. 

 
If the acquired image has been saved, the selected module is immediately accessed when 
the appropriate button is selected. If the image hasn’t been saved, there will be a prompt 
to save it before the image is transferred from ImageQuant Capture to the appropriate 
ImageQuant TL module. 
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Appendix A: Opening ImageQuant 
Capture Files in Other Software 
Programs 
Files generated by ImageQuant have been tested in the software packages below.  For 
successful imports, the command line is given.  
 
Programs for the Macintosh® operating system were tested on a PowerMac® 8100/100AV.  
Results may vary for different software versions and/or hardware configurations. 
 

  .TIF .BMP .GIF .MAC .PCX 
Adobe Photoshop 2.51 LE (Mac) Open no Open Open 

As/TIFF 
no 

Adobe Photoshop 3.0 (Mac) no Open Open   
Canvas 3.5 (Mac) use 

ResEdit* 
no no use 

ResEdit* 
no 

Microsoft Word 6.0 (Mac) Insert 
Picture 

Insert 
Picture 

no Insert 
Picture 

no 

Microsoft Word 6.0a (Win) Insert 
Picture 

Insert 
Picture 

no Insert 
Picture 

Insert 
Picture 

Microsoft Excel 5.0 (Mac) no no no no no 
Microsoft Excel 5.0c (Win) Insert 

Picture 
Insert 

Picture 
no Insert 

Picture 
Insert 

Picture 
NIH Image 1.59 (Mac) Open no no Open no 

 
*For instructions on using ResEdit™, see next page. 
 
Additional packages, such as Claris Works and PowerPoint have also been tested.  For 
these systems, it is necessary to save the file with a “.TIFF” extension in order for them 
to recognize the file as a TIF format.   
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Using ResEdit 
 

1. Save image in IS-1000/500 as a TIFF or MACTIFF 
 
2. Obtain a copy of the freeware ResEdit by downloading from Apple Computers 

through the Internet.  
 

3. Open ResEdit.  An animated startup display will show up and continue until you 
click on the mouse or any key. 

 
4. A dialog box will appear.  Open the TIFF image.  Another dialog box will appear 

asking if you want to add a resource fork, click on ‘OK.’ 
 

5. Next go to the File pull-down menu and click on Get Info for This File. 
 

 
6. In the File Info window, change the Type to TIFF (instead of TEXT), and the 

Creator to DAD2 (instead of DOSA).  (Must be typed in all CAPS as shown 
here).  Close the window and save changes.  Quit ResEdit. 

 
7. After this procedure, the icon will change to a TIFF icon and the file may be 

opened in Canvas. 
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Appendix B: Security Features 
This feature should only be used by the purchaser or supervisor of the system. Remove 
this page from the manual and store it in a safe place. When the system is shared by a 
number of users, security features may be useful for regulating or maintaining a log of 
instrument use.  

To Change the Security Setup 
When you initially receive the system, all security features are inactive and the user name 
and password to access security settings are both set to "MASTER". To change the 
security setup, select the Setup pull-down menu and click on Security.  A dialog box will 
appear asking for the system password: 

 

 
 

Security Dialog Box 
 

Enter the user name and password, and then click on the Login button. A new dialog box 
will appear allowing you to configure your security preferences. By clicking on the 
options in this dialog box, it’s possible for a supervisor to change the system password, 
set the security mode, add and delete names from the authorized list, and activate the 
Auto Logout feature. When the desired options have been selected, click the OK button.  
Follow this procedure any time changes to the security mode are necessary. 
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Security Features Dialog Box 
NOTE: You must exit and re-launch ImageQuant Capture in order for any changes 
to take place.  
 
If you decide not to edit the security settings at this time, simply click on the EXIT button 
to dismiss the dialog box. 

Setting Various Security Levels 
A variety of security levels are available.  Each is described below, in increasing order of 
security.  Also shown are the proper settings in the dialog box to choose each security 
level. 

Option 1:  No Security Functions 
No log in or log out is required and anyone can use the system: 
 

 

Option 2:  Open System with User Name Log In and Out 
This security level keeps the system open but requires users to log into the system by 
typing a name. In this mode, a list of users with their log in and log out times is 
generated. 
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Each time a new name is used, it is added to the master user list.  Since this list requires a 
password (in case the system is later changed to a closed, password protected system), 
ImageQuant will automatically assign the user’s name (in uppercase) as the password, 
and the password field is disabled.  
 
When finished using ImageQuant, the user can choose Logoff from the File menu, or can 
log out by exiting the system.  Otherwise, he/she will remain logged in (unless Auto 
Logout is active). 
 

Option 3:  Open System with User Name and Password Log In and Out 
This security level keeps the system open but requires users to log into the system by 
typing their names and passwords. When someone enters a name and assigns a password 
to that name, the same password is needed whenever that name is used to log in. Only 
one password can be assigned to a name. A list of users with their log in and log out 
times is generated. 
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Option 4:  Closed System with User Name Log In and Out 
A user can log in only by entering an authorized name.  A user log is generated. 
 

 
 
In closed systems, the system supervisor may want to add or remove names from a list of 
authorized users.  To do this, click the Add/Remove Users button.  A dialog box will 
appear with a list of all the current users. 

Option 5:  Closed System with User Name and Password Log In and Out 
The system only accepts authorized names and their passwords at log in. The system 
supervisor can add or remove names from a list of authorized users as described above. 
Only one password can be assigned to each name. A user log is generated. 
 

 
  
Note:  passwords are case sensitive (The login dialog defaults to uppercase but the 
user can override this by pressing the shift key while typing.) 
 


